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What's New

1 What's New

New features in ODBC Driver for Salesforce 3.4

¢ Now tokens and passwords are stored in an encrypted form in the DSN record
¢ Added metadata cache

¢ Improved compatibility with FileMaker Server for Linux and macOS

New features in ODBC Driver for Salesforce 3.3
¢ Added support for macOS ARM (Apple Silicon M1 and M2)

¢ Improved compatibility with 4D in macOS

New features in ODBC Driver for Salesforce 3.2

e Added support for multilevel relations in SOQL queries

¢ Added support for SQL_ATTR_MAX_ROWS attribute

¢ Improved compatibility with Visual Basic in Visual Studio
¢ Improved compatibility with Linked Server in SQL Server

* Improved compatibility with Alteryx

New features in ODBC Driver for Salesforce 3.1
e Added support for macOS 13 Ventura

¢ Improved compatibility with Tableau Prep Builder

¢ Improved compatibility with Crystal Reports

New features in ODBC Driver for Salesforce 3.0
e macOS 64-bit is supported

e Linux 64-bit is supported

New features in ODBC Driver for Salesforce 2.2
e Added support for Windows 11

¢ Improved compatibility with Linked Server in MSSMS
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¢ Improved compatibility with FICO Mosel
¢ Improved compatibility with FileMaker

¢ Improved support for an ODBC installer on Windows 2000

New features in ODBC Driver for Salesforce 2.1
e MSlinstaller for deploying through GPO is added

New features in ODBC Driver for Salesforce 2.0

e OAuth authorization is supported

¢ The ability to execute SOQL queries is added

New features in ODBC Driver for Salesforce 1.8

¢ The ReturnForeignKeys connection option to significantly improve performance is added
e Compatibility with Visual Studio is improved
e SQLProcedures now returns an empty recordset instead of an error

¢ SQLProcedureColumns now returns an empty recordset instead of an error

New features in ODBC Driver for Salesforce 1.7

e Performance of obtaining metadata is improved
e Support for connection pooling is improved
¢ Now ODBC driver activation does not require administrator privileges

¢ The IncludeDeleted connection option, which allows including deleted records into

resultsets, is added

New features in ODBC Driver for Salesforce 1.7
e Possibility to force the ODBC 2.x behavior is added

New features in ODBC Driver for Salesforce 1.6

e Possibility to return String Types as Ansi or Unicode is added

e Compatibility with MS Access is improved
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e Compatibility with Tableau is improved
e Compatibility with Omnis Studio is improved
e Compatibility with Power Pivot is improved

e Compatibility with DBeaver is improved

New features in ODBC Driver for Salesforce 1.5

e Environment selection is added
e Connection Timeout option is added

¢ Query Timeout option is added

New features in ODBC Driver for Salesforce 1.4
e Compatibility with SAS JMP is improved

e Compatibility with MS Power Query is improved
e OUTER JOIN macros in SQL queries are supported
e DateTime macros in SQL queries are supported

e Scalar function macros in SQL queries are supported

New features in ODBC Driver for Salesforce 1.3
e Compatibility with MS Visual Studio

e Compatibility with MS FoxPro is improved

e Compatibility with Maplnfo is improved

e Compatibility with Libre Office is improved

e Compatibility with Qlik is improved

e Compatibility with Delphi & C++Builder is improved

New features in ODBC Driver for Salesforce 1.2
e Compatibility with MS Excel is improved

e Support for linked tables in MS Access is improved

e Backward compatibility of SQLExecDirect with ODBC 2.x is improved
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2.1

New features in ODBC Driver for Salesforce 1.1

e Compatibility with Microsoft SQL Server Management Studio is improved
e Compatibility with MS Access is improved
e Compatibility with Microsoft Visual FoxPro is improved

e Columns with the Formula data type support are improved

New features in ODBC Driver for Salesforce 1.0

e License validation is fixed

e First release of ODBC Driver for Salesforce Marketing Cloud
e Windows 32-bit is supported

¢ Windows 64-bit is supported

© 2015-2024
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General Information

1. Overview

2. Features

3. Compatibility
4. Requirements

5. Licensing
6. Getting Support
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Overview

Overview

ODBC Driver for Salesforce is a high-performance connectivity security with enterprise-level
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features for accessing Salesforce from ODBC-compliant reporting, analytics, Bl, and ETL
tools on Windows, macOS, and Linux. Our ODBC driver fully supports standard ODBC API
functions and data types and enables easy and secure access to live Salesforce data from
anywhere.

/ ODBC API |_—||:‘_‘\

o

+/ ODBC Data Types ‘L
[ |

Connection to Salesforce

Our data connector enables various ODBC-aware applications to connect to Salesforce
directly via HTTPS. If you have no direct access to Salesforce via HTTPS, you have the
option of establishing a connection through a proxy server.

Application
HTTPS
ODBC Interface
Driver Manager Proxy
Salesforce
Devart ODBC driver
for Salesforce
© 2015-2024
Devart. AllRights ~ Request Support ODBC Forum Provide Feedback
Reserved.
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Features

Application

HTTPS

&

Salesforce

0DBC Interface

Driver Manager Proxy

Devart ODBC driver
for Salesforce

Extended SQL Syntax

Our ODBC driver provides an unrivalled
opportunity to work with Salesforce objects
just as with SQL tables. The extended SQL
syntax allows you to use all the SQL
benefits in SQL-92 compatible SELECT

statements:

* Complex JOINs

¢ WHERE conditions

® Subqueries

®* GROUP statements

* Aggregation functions
* ORDER statements

® and more.

Connection to Salesforce

Our connectivity solution enables various
ODBC-aware applications to connect to
Salesforce directly via HTTPS. If you have
no direct access to Salesforce, you have
the option of establishing a connection

through a proxy server.

select
c.FirstName,
c.MailingCountry,
c.MailingStreet,
c.MobilePhone,
a.Accountiumber
from
{select
FirstName,
MailingCountry,
MailingStreet,
MobilePhone,
AccountId
from
Contact
where
MailingCountry = "USA
left join Account a
on c.AccountId = a.Id
where
a.Rating in ('Warm',

‘Y ¢

"Hot ")
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DML Operations Bulk Updates
Devart ODBC Driver for Salesforce Moreover, with our driver you can perform
provides support for DML (INSERT, bulk updates to Salesforce by combining

UPDATE, DELETE) operations, which SQL statements into batches, thus
allows you to modify data in Salesforce in |simplifying and speeding up large data

the same way as in SQL databases. modification with Salesforce.

ODBC Conformance

The driver provides full support for common
ODBC interface:

e ODBC APIFunctions support g € \

= o
U

* ODBC Data Types support

In addition, we provide support for
Advanced Connection String parameters.
Thus allowing any desktop and web
applications to connect to Salesforce from
various environments and platforms, that
support ODBC.
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+/ Salesforce API

+ Salesforce Data Types

Advanced Data Conversion

We have implemented advanced Data
Conversion mechanisms that provide bi-
directional mapping between any

Salesforce and ODBC data types.

Platforms Variety

Devart ODBC Driver for Salesforce can be
used with 32-bit and 64-bit applications on
both x32 and x64 platforms, so there is no
need to additionally configure the driver,

applications or environment.

High Performance

Salesforce Compatibility

Our ODBC driver fully supports all data
types defined in the Salesforce API.
Moreover, the driver is compatible with the

Salesforce APl itself.

Integration

The driver is compatible with 3rd-party data
analysis tools, such as Microsoft Excel, and
integrates with various IDEs and systems
like Visual Studio, etc.

For a complete list of compatible tools and

platforms, see Compatibility.

Fully Unicode Driver

With our fully Unicode driver, you can
retrieve and work with any data from muilti-
lingual Salesforce databases correctly, not
depending on whether its charset is Latin,
Cyrillic, Hebrew, Chinese, etc., in any

environment localization.

Support
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Every operation with Salesforce becomes | )
Visit our Support page to get instant help

significantly faster using such capabilities .
from knowledgeable and experienced
of our driver as Local data caching, _ _ _
professionals, a quick resolution of your
connection pooling, query optimization and . . .
problems, and nightly builds with hotfixes.
much more.

© 2015-2024
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Reserved.

2.3 Compatibility

Salesforce Compatibility
Salesforce API v/
Salesforce Data Types v

Supported Platforms

e Windows 32-bit and 64-bit (including Windows Terminal Server)

e Compatible with all Windows versions (Windows 7 and higher) that support .NET 5.0
e macOS 64-bit

¢ Linux 64-bit

Compatibility with Third-Party Tools

Application Development Tools

Adobe ColdFusion vy
Embarcadero Delphi & C++Builder W,
FileMaker v
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Lazarus

Microsoft Visual FoxPro

Microsoft Visual Studio

Server Explorer and ADO.NET ODBC Provider

Omnis Studio

PHP

PowerBASIC

Python

CIC IS L [C KK

Database Management

Aqua Data Studio

DBArtisan

dbForge Studio

dBeaver

EMS SQL Management Studio

Informatica Cloud

RazorSQL

SQL Server Data Tools

SQL Server Management Studio

SQL Server Reporting Services

CIC SISO K

Bl & Analytics Software

Alteryx

<

DBxtra

<
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Dundas Bl

FICO Xpress Mosel

IBM SPSS Statistics

MicroStrategy

Oracle Bl

Power Bl

Qlik Sense

QlikView

RStudio

SAP Crystal Reports

SAS JMP

Tableau

TARGIT

CICC SISO IS LSS

TIBCO Spotfire

Office Software Suites

LibreOffice

Microsoft Access

Microsoft Excel

OpenOffice

CIC LSS

StarOffice

© 2015-2024
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2.5

Requirements

The following requirements must be met for ODBC Driver for Salesforce:

¢ Only one version of ODBC Driver for Salesforce is installed on your system.

e NET Framework 4.5 or later is installed on your system.

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

Licensing

ODBC Driver License Agreement

PLEASE READ THIS LICENSE AGREEMENT CAREFULLY. BY INSTALLING OR USING
THIS SOFTWARE, YOU INDICATE ACCEPTANCE OF AND AGREE TO BECOME BOUND
BY THE TERMS AND CONDITIONS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE
TERMS OF THIS LICENSE, DO NOT INSTALL OR USE THIS SOFTWARE AND
PROMPTLY RETURN IT TO DEVART.

INTRODUCTION

This Devart end-user license agreement ("Agreement") is a legal agreement between you
(either an individual person or a single legal entity) and Devart, for the use of the ODBC Driver
software application, demos, intermediate files, printed materials, and online or electronic
documentation contained in this installation file. For the purpose of this Agreement, the
software program(s) and supporting documentation will be referred to as the "Software".

LICENSE
1. GRANT OF LICENSE

The enclosed Software is licensed, not sold. You have the following rights and privileges,
subject to all limitations, restrictions, and policies specified in this Agreement.

1.1. If you are a legally licensed user, depending on the Software Edition specified in the
registration letter you have received from Devart upon purchase of the Software:

- the "Desktop Edition" allows you to install and use the Software on a single desktop

© 2024 Enter your company name
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computer, provided it is accessed by no more than one person at a time, either directly or
remotely, for sole purposes only in accordance with this Agreement. If more than one person
can simultaneously use the computer where you plan to install the product, you must
purchase a Server License. A Desktop License is valid for one single desktop installation;

- the "Server Edition" allows you to install and use the Software on a single server, provided it
is accessed by more than one person at a time, either directly or remotely. This definition
includes, but is not limited to, Web servers, application servers, batch servers, and desktop
workstations, where more than one concurrent users can access the Software. A Server
License is valid for one single server installation, provided it is used by 1 (one) legal entity in
accordance with this Agreement.

1.2. If you are a legally licensed user, depending on the License Type specified in the
registration letter you have received from Devart upon purchase of the Software:

- the "Subscription-based License" allows you to install and use the Software on a single
computer only during the subscription term specified at purchase. An Internet connection is
required to activate the license and check the license status when the Software is used.
Once the subscription term is over, you will be able to either stop using the Software or renew
the license for a new subscription term;

- the "Perpetual License" allows you to install and use the specific Software product version
on a single computer without an active subscription. A subscription provides access to new
product releases, regular upgrades, and support for new server versions provided during the
subscription term;

- the "Site License" allows you to install and use the Software on one or more computers in a
single company in accordance with this Agreement;

- the "OEM License" allows you to install and use the Software on one or more computers in
a single company as well as deploy the Software as part of a licensee's application to web
servers, application servers, batch servers, desktops, and other end-user devices. This
definition includes the ability to install and use the application containing the Software without
any additional fees in favor of the licensor.

1.3. If you are a legally licensed user of the Software, you are also entitled to:

- make one copy of the Software for archival purposes only, or copy the Software onto the
hard disk of your computer and retain the original for archival purposes;

© 2024 Enter your company name
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- develop and test Applications with the Software, subject to the Limitations below.
1.4. If you have the "OEM License", you are also entitled to:
- make any number of copies of the Software to deploy it to your end-user.

- deploy the Software to your end-user as a Software installation package or integrate it into
your Applications.

1.5. You are allowed to use evaluation versions of the Software as specified in the Evaluation
section.

No other rights or privileges are granted in this Agreement.
2. LIMITATIONS

Only legally registered users are licensed to use the Software, subject to all of the conditions
of this Agreement. Usage of the Software is subject to the following restrictions.

2.1. You may not reverse engineer, decompile, or disassemble the Software.

2.2. You may not reproduce or distribute any Software documentation without express written
permission from Devart.

2.3. You may not distribute and sell any portion of the Software integrating it into your
Applications.

2.4. You may not transfer, assign, or modify the Software in whole or in part. In particular, the
Software license is non-transferable, and you may not transfer the Software installation
package.

2.5. You may not remove or alter any Devart's copyright, trademark, or other proprietary rights
notice contained in any portion of Devart files.

3. REDISTRIBUTION

The license grants you a non-exclusive right to reproduce any new software programs
(Applications) created using the Software. You cannot distribute the Software integrated into
your Applications unless you are an "OEM License" holder. Any Devart's files remain Devart's
exclusive property.

4. TRANSFER

You may not transfer the Software to any individual or entity without express written

© 2024 Enter your company name
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permission from Devart. In particular, you may not share copies of the Software under
"Desktop License" with other co-developers without obtaining proper license of these copies
for each individual; you may not install the Software under "Server License" on more than 1
(one) server without obtaining proper license of these installations for each server.

5. TERMINATION

Devart may immediately terminate this Agreement without notice or judicial resolution in the
event of any failure to comply with any provision of this Agreement. Upon such termination
you must destroy the Software, all accompanying written materials, and all copies.

6. EVALUATION

Devart may provide evaluation ("Trial") versions of the Software. You may transfer or
distribute Trial versions of the Software as an original installation package only. If the Software
you have obtained is marked as a "Trial" version, you may install and use the Software for a
period of up to 30 calendar days from the date of installation (the "Trial Period"), subject to the
additional restriction that it is used solely for evaluation of the Software and not in conjunction
with the development or deployment of any application in production. You may not use
Applications developed using Trial versions of the Software for any commercial purposes.
Upon expiration of the Trial Period, the Software must be uninstalled, all its copies and all
accompanying written materials must be destroyed.

7. WARRANTY

The Software and documentation are provided "AS IS" without warranty of any kind. Devart
makes no warranties, expressed or implied, including, but not limited to, the implied
warranties of merchantability and fitness for a particular purpose or use.

8. SUBSCRIPTION AND SUPPORT

The Software is sold on a subscription basis. The Software subscription entitles you to
download improvements and enhancement from Devart's web site as they become available,
during the active subscription period. The initial subscription period is one year from the date
of purchase of the license. The subscription is automatically activated upon purchase, and
may be subsequently renewed by Devart, subject to receipt applicable fees. Licensed users
of the Software with an active subscription may request technical assistance with using the
Software over email from the Software development. Devart shall use its reasonable
endeavors to answer queries raised, but does not guarantee that your queries or problems
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2.6

will be fixed or solved.

Devart reserves the right to cease offering and providing support for legacy Database
versions.

9. COPYRIGHT

The Software is confidential and proprietary copyrighted work of Devart and is protected by
international copyright laws and treaty provisions. You may not remove the copyright notice
from any copy of the Software or any copy of the written materials, accompanying the
Software.

This Agreement contains the total agreement between the two parties and supersedes any
other agreements, written, oral, expressed, or implied.
© 2015-2024

Devart. All Rights Request Support ODBC Forum Provide Feedback
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Getting Support

This document lists several ways you can find help with using ODBC Driver for Salesforce
describes the Priority Support program.

Support Options

There are a number of resources for finding help on installing and using ODBC Driver for
Salesforce:

¢ You can find out more about ODBC Driver for Salesforce installation or licensing by

consulting Installation and License articles of this manual respectively.

¢ You can get community assistance and technical support on the Community Forum.

¢ You can get advanced technical assistance by ODBC Driver for Salesforce developers

through the ODBC Driver for Salesforce Priority Support program.

Subscriptions

The ODBC Diriver for Salesforce Subscription program is an annual maintenance and

support service for ODBC Driver for Salesforce users.

© 2024 Enter your company name
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Users with a valid ODBC Driver for Salesforce Subscription get the following benefits:

e Product support through the ODBC Driver for Salesforce Priority Support program
e Access to new versions of ODBC Driver for Salesforce when they are released
e Access to all ODBC Driver for Salesforce updates and bug fixes

¢ Notifications about new product versions

Priority Support

ODBC Driver for Salesforce Priority Support is an advanced product support service for
getting expedited individual assistance with ODBC Driver for Salesforce-related questions
from the ODBC Driver for Salesforce developers themselves. Priority Support is carried out
over email and has a two business day response policy. Priority Support is available for users
with an active ODBC Driver for Salesforce Subscription.

To get help through the ODBC Driver for Salesforce Priority Support program, please send an
email to odbc@devart.com describing the problem you are having. Make sure to include the

following information in your message:

Your ODBC Driver for Salesforce Registration number.

e Full ODBC Driver for Salesforce edition name and version number. You can find the version
number in DLL version information.

¢ Versions of the Salesforce server and client you are using.

e A detailed problem description.

e [f possible, ODBC Administrator Log, scripts for creating and filling in database objects, and

the application using ODBC Driver for Salesforce.

If you have any questions regarding licensing or subscriptions, please see the FAQ or
contact sales@devart.com

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

3 Using ODBC Driver
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3.1

3141

1. Installation

2. Product Activation

3. Connecting to Salesforce

4. Connection String Parameters
5. Enabling ODBC Tracing
Using SOQL Queries

6. Supported Data Types
7. Supported ODBC API Functions

© 2015-2024
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Installation

Provide Feedback

ODBC Driver for Salesforce currently supports the following platforms: Windows, macOS,

and Linux, both 32-bit and 64-bit.

¢ Windows - Regular Installation

¢ Windows - Silent Installation

e macOS
e Linux DEB
e Linux RPM

© 2015-2024
Devart. All Rights Request Support

ODBC Forum

Reserved.

Windows

Installation

1. Download and run the installer.

2. Follow the instructions in the wizard.

Provide Feedback
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i3 setup - Devart ODBC Driver for Salesforce — *

devc r‘t Welcome to the Devart ODBC Driver for
Salesforce Setup Wizard
This will install Devart ODBC Driver for Salesforce 1,713 on

your computer,

Itis recommended that vou dose all other applications before
continuing.

Click Mext to continue, ar Cancel to exit Setup.

w WARMNING: This program is protected by copyright law and
international treaties.

ODBC Driver
for Salesforce

3. In case if you already have the specified installation folder on the PC or another Driver
version is installed, you will get a warning. Click Yes to overwrite the old files with the
current installation, but it is recommended to completely uninstall the previous driver
version first, and then install the new one.

4. On the Select Components page you can select whether to install the 64-bit version of the
driver or not. Clear the check box if you need no 64-bit installation. There is also a check

box on this page, that allows you to select whether to install Help and Manual.
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5 Setup - Devart ODBC Driver for Salesforce — >
Select Components
Which components should be installed? dewvart

Select the components you want to install; dear the components you do not want to
install. Click Mext when you are ready to continue.

Full installation w
Devart QDBC Driver for Salesforce 15,4 MB
i [+] Driver for Win32 &,7 ME
. [] Driver for Wing4 8,8 ME
Help and Manual 6,7 ME

Current selection requires at least 23,8 MB of disk space.

5. In the License Information dialog box, you should select the license type and activate the
product. If you have no activation key, you can select Trial and use the driver for evaluation
purposes.

6. If you have an activation key, select the Activation Key option. Copy the activation key from
the registration email or your Customer Portal account and paste it into the Activation Key

edit box.
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i% setup - Devart ODBC Driver — >
License Information
Fleaze enter the path to the file containing the activation key received when devart

purchasing the product. If you have no activation key, select Trial Version.

() Trial
(®) Activation Key

u 1w FjNOD SMGAPOSgfMzjuY AEoDpy fgL¥mIX heuy Hadt S8M4F ZgxWheiBjxwr LS

7 15QYwWOUQOeY Tatef2NfkwL gB +HFAVeYghal 3nMhifdvYIriwFFwZNVIRh 2m4s ]
72EIxR 30F{9BLspR & ydbomx YUY mTAZ FHMQVXWPGQN 2UM 1Y 4odf3c3TTj IRAUAG 2d
eminjcTIIN4HEPxigTQRRGZBHKT 1L 3IAR 1/ f¥sIp/PiKknDSIbxVK +avkETuP

5Qw 1IKL 7hTw0dwStsheAtwPzLEaTi30CHY 3 +2MLSII3 =|

Load Activation Key ...

7. If you have the activation key file, click the Load Activation Key button and browse to it.

Activation — O X

= v « Do, * Activation v O Search Activat.. 2

= This PC Mame Date modified Type

. 30 Ohbj E activation 27.03.2020 13:52 KEY File
I Desktoj
|j Docurm
4 Downlo

D Music v < >

1 itemn

8. Click Next.
9. Click Install, then Finish.

10.After the installation is completed, you need to configure the driver.
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3.1.2

313

See also:

¢ |nstallation on macOS

¢ Install Linux DEB package

¢ |nstall Linux RPM package

© 2015-2024
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Silent

Silent Installation with OEM license on Windows

1. Run the Command Prompt as an administrator.

2. Use the following command-lines to perform the driver silent/very silent installation:

DevartODBCSalesforce.exe /SILENT /ActivationKey=ylc7nmgdu234TlaszxcvONGurjfhx
DevartODBCSalesforce.exe /VERYSILENT /ActivationkKey=ekhdh765mh09ukr237gfHRtr
Note: The installation is performed by entering a license key.

DevartODBCSalesforce.exe /SILENT /ActivationFile=d:\1lic.key
DevartODBCSalesforce.exe /VERYSILENT /ActivationFile=d:\Tic.key

Note: The installation is performed by specifying the path to a license key file with any name.

When /SILENT is used, the installation progress is displayed, but no user interaction is
required during installation.

When /VERYSILENT is used, the installation wizard dialog is hidden and the installation
process is performed without user interference.
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macOS

Prerequisites
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ODBC Driver for Salesforce works under control of an ODBC driver manager. ODBC driver
manager is not distributed along with our driver and must be installed separately.

ODBC Driver for Salesforce is compatible with iODBC driver manager.

In case when using other ODBC driver managers, ODBC Driver for Salesforce will be
installed, but it will require manual modification of configuration files of these managers.

Installing ODBC Driver for Salesforce
1. Go to Security & Privacy settings in the System Preferences.

2. Enable the App Store and identified developers option in the Allows apps downloaded

from section.
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[ ] 4 G Security & Privacy Q

m FileVault = Firewall  Privacy

A login password has been set for this user Change Password...

Require password 5 minutes B after sleep or screen saver begins
Show a message when the screen is locked

Disable automatic login

Use your Apple Watch to unlock apps and your Mac

Allow apps downloaded from:

) App Store
° App Store and identified developers

o’
Eﬁ Click the lock to prevent further changes. Advanced... ?

Note: If the options in Allow apps downloaded from section are grayed out, click on the

lock icon and enter your administrator password to proceed with the installation.

3. Download the PKG file from the Devart website.

4. Run the downloaded file, press the Allow button to proceed with the installation.
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® |ntroduction

w Install Devart ODBC Driver for Salesforce

Welcome to the Devart ODBC Driver for Salesforce Installer

This will install Devart ODBC Driver for Salesforce 2.2.1 on your
computer.

WARNING: This program is protected by copyright law and international
treaties

Continue

25

5. After reading the license agreement, click Agree.
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w Install Devart ODBC Driver [

To continue installing the software you must agree to the terms of
the software license agreement.

g Click Agree to continue or click Disagree to cancel the installation and
Rei guit the Installer.
o Lic
Re MS
! Read License Disagree Agree
De|
Installation Type
i INTRODUCTION
Installation
c This Devart end-user license agreement ("Agreement”) is a legal
Sl agreement between you (either an individual person or a single legal

entity) and Devart, for the use of the ODBC Driver software application,
demos, intermediate files, printed materials, and online or electronic
documentation contained in this installation file. For the purpose of this
Agreement, the software program(s) and supporting documentation will
be referred to as the "Software”.

LICENSE

Print... Save... Go Back Continue

6. In the License Information dialog box, you should select the license type and activate the

product. If you have no activation key, you can select Trial and use the driver for evaluation

purposes.

7. If you have an activation key, select the Activation Key option. Copy the activation key from

the registration email or your Customer Portal account and paste it into the Activation Key

edit box.
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@®C

@ Introduction
© Read Me

© License

© Registration

Destination Select
Installation Type
Installation

Summary

‘& Install Devart ODBC Driver
Registration

License information
Please enter the path to the file containing the activation key
received when purchasing the preduct. If you have no
activation key, select Trial Version.

I Trial
°' Activation Key

d1asbaFDhafkésHdrnfbvwncnve TR4i11+GDVFC465furdxawBMNYCru
bbv3546ifa6a7litkbbhuvDFaHre2965+gvefxixtrd23nmbCVBrut!/
q1f2b7==chhfvritviXcvRfyurkawRThabvyvuTrwo09/65ii TRABMNNYVCrb
b4 56T Kiiguuvbh

Load Activation Key ...

Go Back Continue
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8. If you have the activation key file, click the Load Activation Key button and browse to it.
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o0 e
< aa

Desktop
oo o

000
ooo

Q, Search

Favorites
@ AirDrop
™ iCloud Drive
& All My Files
7‘3\; Applications
=] Desktop
ﬁj Documents
0 Downloads

Devices
Remote Disc

Shared
server

@ Al

[

R
,

test

9. To complete the installation click Continue, then Install buttons.
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[ ] & Install Devart ODEC Driver [

The installation was completed successfully.

Introduction
Read Me
License
Registration

Destination Select The installation was successful.

Installation Type The software was installed.

Installation

Summary

To activate the driver, perform the steps described in the Product Activation article.

See also:

¢ |nstallation on Windows

¢ |nstall Linux DEB package

¢ Install Linux RPM package
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314 LinuxDEB

Prerequisites
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ODBC Driver for Salesforce works under control of an ODBC driver manager. ODBC driver
manager is not distributed along with our driver and must be installed separately.

ODBC Diriver for Salesforce is compatible with UnixODBC driver manager. You can install

the unixODBC driver manager using the command below:

sudo apt-get install odbcinstldebian2 libodbcl odbcinst unixodbc

In case when using other ODBC driver managers, ODBC Driver for Salesforce will be
installed, but it will require manual modification of configuration files of these managers.

For Ubuntu 22.04 LTS

Devart ODBC Driver for Salesforce requires openssl-1.1 library pre-installed. If you do not
have it installed, you need to install it before installing the ODBC Driver for ODBC Driver for
Salesforce. You can install the libraries using the commands below.

Retreive the .deb library installation file:

wget http://nz2.archive.ubuntu.com/ubuntu/pool/main/o/openssl/1libssl1.1_1.1.1f-
lubuntu2.16_amd64.deb

Install the previously fetched file:

sudo dpkg -i libssl1.1_1.1.1f-1ubuntu2.16_amd64.deb

Installation

Let's consider how to install the Devart ODBC driver on Linux from a DEB package, for
example, on Ubuntu. There are two ways to install the driver either manually or via the
command line.

GUI installation
1. Download the DEB package of the required bitness from the Devart website.

2. Navigate to the folder with the downloaded package ("Downloads" by default) and double-
click it.

3. In the opened dialog, click the Install button.
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devartodbcsalesforce -

devartodbcsalesforce
New level of functionality and performance in data access via ODBC

Devart ODBC Driver for Salesforce provides a high-performance and feature-rich connectivity solution for ODBC-based
applications to access Salesforce databases from Windows, macOS, Linux, both 32-bit and 64-bit. Full support for
standard ODBC API functions and data types implemented in our driver makes interaction of your database applications
with Salesforce fast, easy and extremely handy.

Website
Details
Version 2.21
Updated 12.05.22

License Proprietary
devartodbcsalesforce_amdé4.deb

26,0MB
0 bytes

4. If the installation is successfully completed, the Install button changes into the Remove

one.

Command-line installation
1. Download the DEB package from the Devart website.

By default the required package will be downloaded into the ~/Downloads folder (or the
selected one);

2. Run the 'Terminal' program;

3. Navigate to the folder with the downloaded package cd ~/Downloads (if you downloaded

the package into another folder, you need to specify the path to this folder as the cd

command parameter):

cd ~/Downloads/

© 2024 Enter your company name



https://www.devart.com/odbc/salesforce/download.html

32

ODBC Driver for Salesforce

3.1.5

4. To install the devartodbcsalesforce_amd64.deb on a 64-bit system, use the following

command:

sudo dpkg -i devartodbcsalesforce_amd64.deb

cd ~/Downloads/

S
S sudo dpkg -1 devartodbcsalesforce amd64.d

5. Driver is installed successfully.

:~§5 cd ~/Downloads/
S sudo dpkg -i devartodbcsalesforce amdé4.d
eb
[sudo] password for ubuntu:
(Reading database ... 179250 files and directories currently installed.)

Preparing to unpack devartodbcsalesforce amdé4.deb ...
Unpacking devartodbcsalesforce (2.2.1) over (2.2.1) ...
Setting up devartodbcsalesforce (2.2.1) ...

: $

To activate the driver, perform the steps described in the Product Activation article.

See also:
e |nstall Linux RPM package

¢ |nstallation on Windows

¢ |nstallation on macOS
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Linux RPM

Prerequisites
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ODBC Driver for Salesforce works under control of an ODBC driver manager. ODBC driver

manager is not distributed along with our driver and must be installed separately.
ODBC Diriver for Salesforce is compatible with UnixODBC driver manager.

In case when using other ODBC driver managers, ODBC Driver for Salesforce will be
installed, but it will require manual modification of configuration files of these managers.

Installation

Let's consider how to install the Devart ODBC driver on Linux from an RPM package, for
example, on CentOS. To install the driver, you should download the .rpm package and install
it via the command line. See the detailed description of these steps below:

1. Download the RPM package from the Devart website.

By default the required package will be downloaded into the ~/Downloads folder (or the
selected one);

2. Run the 'Konsole' program;
3. Navigate to the folder with the downloaded package cd ~/Downloads (if you downloaded
the package into another folder, you need to specify the path to this folder as the cd

command parameter):

cd ~/Downloads/

[test@localhost ~]1% cd ~/Downloads/

[test@localhost Downloads]%

4. To install the devart-odbc-salesforce.x86_64.rpm on a 64-bit system, use the following

command:;

sudo rpm -ivh devart-odbc-salesforce.x86_64.rpm

[test@localhost DﬂwnlﬂadS]E sude rpm -ivh devart-odbc-salesforce.x86 64.rpm

5. Driver is installed successfully.

© 2024 Enter your company name


https://www.devart.com/odbc/salesforce/
http://www.unixodbc.org
https://www.devart.com/odbc/salesforce/download.html

34 ODBC Driver for Salesforce

nloads/
sudo rpm -ivh devart-odbc-salesforce.x86 64.rpm

Updating / in%tallinq...
evart-odbc-salesforce-2.2.1
centos7x64 Downloadsls |}

To activate the driver, perform the steps described in the Product Activation article.

See also:
¢ Install Linux DEB package

¢ |nstallation on Windows

¢ |nstallation on macOS
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3.2 Product Activation

e Obtaining Activation Key

e Activation on Windows

e Where to see the license information
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3.21 Obtaining Activation Key

To obtain a product activation key, follow these instructions:
1. After purchasing the license, you receive a registration email to the email address,

specified when ordering the product.

2. This email contains a Driver Activation Key and Login Credentials for the Customer Portal.

Keep this information secret.

3. You can copy the Activation Key either from the registration email or at the Customer Portal
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account.

4. To login to the Customer Portal, use your Username and Password from the registration

email.

5. To obtain your Activation Key, click the View link on the right. You will get the following

dialog box:

Activation Key

ulw7jCODENGAEOFgbMNzjuTATOD W gLMNmDXMeuy+kt2YIoV39cp39ihBIIZ6mCh
MhlQfsILhFIgrEhQWx TEmuz 1)i+1QyeFEPkmX+Z5Y QP Xt7ebxgMUSHsUdPjVskis
93Ee03mgHGawWISSQXuKKBzPIxDIB1toSHSvmpp LEEXvIaOkPRhdaraaud UK
rEdrz GOuk5)dOMzeyk(Q==

COPY TO CLIPEQARD CLOSE

6. Copy the Activation Key with the Copy to Clipboard button.

See also:

e Activation on Windows
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3.2.2 Activation on Windows

Driver Activation After Installation

To activate your installed driver using ODBC Administrator, perform the following steps:
1. Run ODBC Administrator.
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Data Sources
(QDBC)

2. In the System DSN tab click the Add button.

; ODBC Data Source Administrator (4-bit) >

User DSM  System DSN  File DSM  Drivers Tracing Connection Pooling  About

System Data Sources:

Mame Platform  Driver 2 Add...
QDB Driver for Azure_x32 J2+bit Devart QDBC Driverfor SAL S

QODBC Driver for BigCommerce_x32 32-bit Devart QDBC Driver for BigCor Remaove
QDBC Driver for Dynamics_32 32bit Devart QDBC Driver far Dynam

ODBC Driver for Firebird_x32 32-bit Devart ODBC Driver for Firebir: Configure...

QDBC Driver for Magento_x32 J2-bit Devart QDBC Driver for Mager
QODBC Driver for MailChimp_x32 32bit Devart QDBC Driver far MailCh
QDBC Driver for MangoDB Gd-bit Devart QDBC Driver far Mongao
QDBC Driver for MangoDB_x32 32bit Devart QDBC Driver far Mongao

QODBC Driver for MySGL 32bit 32bit Devart ODBC Driver for MySGI1 Y
£ >

An QODBC System data source stores information about how to connect to the indicated data provider.
A System data source is visible to all users of this computer, including NT services.

B

Cancel Apphy Help

3. In the appeared dialog box, select the installed driver, click Finish.

© 2024 Enter your company name



Using ODBC Driver

Create Mew Data Source

Select a driver for which you want to set up a data source.

Mame T4

Devart QDBC Driver for BigCommerce

Devart QDBC Driver for Dynamics CRM

Devart ODBC Driver for Firebird .
Devart ODBC Driver for FreshBooks i
Devart QDBC Driver for Google BigGueny ’
Devart ODBC Driver for InterBase .
Devart QDBC Driver for Magento i

m Tl r B e

< >

< Back Cancel
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4. In the Driver Configuration dialog box, on the License tab, click the Input Activation Key

button.
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| General Advanced Settings License  About

License Information:

Trial period:
30 days left |

Input Activation Key...

Test Connection . 0K Cancel

5. Copy the activation key from the registration email carefully and paste it into the Input

Activation Key edit box.

Input Activation Key

Activation Key:

U 1w FRODEBGAEIFgbMZUTAToG v faLMmIX fheuy HdSpWCSKTE +d 2ZIwrmnI +A4A
u lw FCODENGAEDIFgbNzZiuTg ToD v /gLMmIX heuy Hel 5 IN4ZZgxWh 2MiXwr IS
A7E 103mgH6a 5w 1S fSQXuKKSzPIxDIS 1to 5 5vmppiL3EXvIaOkPRh4araausUf
a9BZh4ERVELA /pR IHWLZSXZ8k00 12Cx FaGy v 1¥hiknLRK 2L sbLMLP&mbxBC 2gn
WEZSMMErH72950xNiFvtZ IFnMsC 7 4scOuigWQsRed s =

Load Key...

Cancel

6. If you have the activation key file, click the Load Key button and browse to it.
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7. Click OK.
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3.2.3 Where to See the License Information?

To see the license information of your installed driver, do the following:
1. In the Control Panel run ODBC Administrator

Data Sources
(QODBC)

2. Open the System DSN tab and click the Add button
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System Data Sources:

E ODBC Data Source Administrator (4-bit)

User DSM  System DSN  File DSN  Drivers  Tracing Connection Pooling  About

Mame Platform

QODBC Driver for Azure_x32 32bit
QODBC Driver for BigCommerce_x32 32-bit
QDBC Driver for Dynamics_32 32bit
QDBC Driver for Firebird_x32 32bit
QDBC Driver for Magento_x32 32bit
QODBC Driver for MailChimp_x32 32bit
QDBC Driver for MangoDB Gd-bit
QDBC Driver for MangoDB_x32 32bit

ODBC Driver for MySQL 32bit 32 -bit
£

Diriver

Devart QDBC Driverfor SAL 5
Devart QDBC Driver for BigCor
Devart QDBC Driver far Dynam
Devart QDBC Driver for Firebirc
Devart QDBC Driver for Mager
Devart QDBC Driver for MailCh
Devart QDBC Driver far Mongao
Devart QDBC Driver far Mongao

Devart ODBC Driver for MySQI ¥

>

B

An QODBC System data source stores information about how to connect to the indicated data provider.
A System data source is visible to all users of this computer, including NT services.

Cancel

Add...

Remove

Configure...

Apply Help

3. Select the driver and click Finish
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Create Mew Data Source

Select a driver for which you want to set up a data source.

Mame T4

Devart QDBC Driver for BigCommerce

Devart QDBC Driver for Dynamics CRM

Devart ODBC Driver for Firebird .
Devart ODBC Driver for FreshBooks i
Devart QDBC Driver for Google BigGueny ’
Devart ODBC Driver for InterBase .
Devart QDBC Driver for Magento i

m Tl r B e

< >

< Back Cancel

4. In the appeared dialogue, select the License tab

4
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3.24

General Advanced Settings License  About

License Information:

Trial period:
30 days left |

Input Activation Key...

Test Connection . 0K Cancel

See also
e Product Activation

© 2015-2024
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Activation on macOS

Driver Activation After Installation

If you don'’t activate your driver during installation, you can activate it later by following the
steps:

1. Create a file with the "activation.key" name.
2. Copy the activation key from the registration email or your Customer Portal account and

paste it into the created file.
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3. Place the "activation.key" file into the folder where the driver was installed (for Devart

ODBC Driver for Salesforce it is /Library/ODBC/Devart/Salesforce by default).

See also:

e Activation on Windows

e Activation on Linux
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3.2.5 Activation on Linux

Driver Activation After Installation

If you did not activate the driver during installation, you can activate it later:

1. Create a file with the "activation.key" name.
2. Copy the activation key from the registration email or your Customer Portal account and
paste it into the created file.

3. Place the "activation.key" file into the folder where the driver was installed:
- for the DEB package of Devart ODBC Driver for Salesforce, it is /usr/share/devart/
odbcsalesforce by default;

- for the RPM package of Devart ODBC Driver for Salesforce, it is /usr/local/devart/
odbcsalesforce by default.

See also:

e Activation on Windows

e Activation on macOS
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3.3

3.341

Connecting to Salesforce

See how to connect the Devart ODBC Driver for ODBC Driver for Salesforce:

¢ \Windows DSN Configuration

e macOS DSN Configuration

¢ Linux DSN Configuration
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Windows

Windows DSN Configuration

After installing the driver, create a DSN for Salesforce in the ODBC Data Source
Administrator.

1. Open the ODBC Data Source Administrator.

e Type opBC Data Sources in the Windows search box and choose the application that
matches the bitness of the third-party application (32-bit or 64-bit). You can also open
ODBC Data Sources from Control Panel > Administrative Tools. Note that before
Windows 8, the icon was named Data Sources (ODBC).

e Alternatively, you can run c:\Windows\SysWOW64\odbcad32.exe to create a 32-bit DSN or c:
\Windows\System32\odbcad32.exe to create a 64-bit DSN.

2. Select the User DSN or System DSN tab. Most applications work with both types, yet
some applications require a specific type of DSN.

3. Click Add. The Create New Data Source dialog will appear.

4. Select Devart ODBC Driver for ODBC Driver for Salesforce and click Finish. The
driver setup dialog will open.

5. Enter the connection information in the appropriate fields.

By default, the authentication is set to OAuth 2.0.
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Devart ODBC Driver for Salesforce Configuration X

General Advanced Settings License  About

Data Source Mame  Salesforce

Description Devart ODBC Driver for Salesforce
Production e
Server login, salesforce, com
Authentication Cauth 2.0 A
Refresh Token [save Token

Sign In with Salesforce

Proxy Server Port 0
Proxy User ID

Proxy Password [ save Password
Test Connection E] 0.4 Cancel

You can also change authentication and connect to the data source with a user ID and
password.
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Devart ODBC Driver for Salesforce Configuration

General Advanced Settings License  About

Data Source Mame  Salesforce

Description

Server
Authentication
User ID
Password

Security Token

Proxy Server
Proxy User ID

Proxy Password

Devart QDBC Driver for Salesforce

Production v
login, salesforce, com
User ID and Password e

devart@agmail. com

(YTYT] B save Password

[|save Password

Test Connection

K Cancel

Port 0
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Devart ODBC Driver for Salesforce Configuration X

General Advanced Settings License  About

Data Source Mame  Salesforce

Description Devart ODBC Driver for Salesforce
Production e
Server login, salesforce, com
Authentication Cauth 2.0 A
Refresh Token [save Token

Sign In with Salesforce

Proxy Server Port 0

Proxy User ID

Proxy Password [|save Password

Test Connection E] 0K Cancel

6. You may test the connectivity by clicking Test Connection.

7. Click OK to save the DSN.

See Also
Connection Options
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3.3.2 Mac

macOS DSN Configuration

After the driver is installed, DSN with the name DEVART_SALESFORCE is created. You can
use it to test a connection with SALESFORCE server. For this, perform the following steps:
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1. Run the iODBC utility of the required bitness. Find the DEVART_SALESFORCE section

and click the Configure button:

Connecticn Pooling Tracing About

Add

[ ] iODBC Data Source Administrator (Intel 64bit)
User DSN System DSN File DSN ODBC Drivers
System Data Sources
Mame Description Driver

DEVART_SALESFORCE -

Devart ODBC Driver for Salesforg

Source connection information.

System Data Source Names create systems-wide ODBC Data Names that resclve to Data

Cancel

2. In the appeared dialog, specify the required connection settings and click OK.

© 2024 Enter your company name



Using ODBC Driver 49

L ] Setup of DEVART_SALESFORCE

Comment

Keyword

Data Source
User ID
Password
Security Token

Data Source Name (DSN) DEVART_SALESFORCE

Value

login.salesforce.com
test123@gmail.com
data123
ju2gQo0_16MbzaWe76

Cancel

3. Now click the Test button to establish a test connection to your data source.
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3.3.3

[ ] iODBC Data Source Administrator (Intel 64hit)

User DSN System DSN File DSN ODBC Drivers Connection Pooling Tracing About

System Data Sources

Mame Description Driver Add
DEVART_SALESFORCE - Devart ODBC Driver for Salesfor Remove
Configure
Test

System Data Source Mames create systems-wide ODBC Data Mames that resolve to Data

@ Source connection information.

concel (D

See Also
Connection Options
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Linux

Linux DSN Configuration

After the linux (DEB or RPM) driver is installed, a DSN with the name
DEVART_SALESFORCE is created. You can use it to test the connection with the
SALESFORCE server. For this, perform the following steps:

1. Open the odbc.ini file located in the /etc folder. Find the DEVART_SALESFORCE section

and specify the required connection settings:
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User ID=<your Salesforce User Name>
Password=<your Salesforce password>
Server=<your Salesforce server address>
Port=<your Salesforce Port>
Database=<your Salesforce database name>

2. Run the UnixODBC Test Command utility and test a connection using the following

command:

isql -v DEVART_SALESFORCE

test@ubuntu:~5 isql -v DEVART_SALESFORCE
Connected!
sql-statement

help [tablename]
quit

-
|
|
|
|
|
I

See Also
Connection Options
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3.4 Connection String Parameters

Salesforce ODBC Connection String Parameters
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The following table lists the connection string parameters for Salesforce.

Paramet
er

Description

The authentication type to use when connecting to Salesforce. Defaults to
OAuuth.
OAuth

Authenticati
on The OAuth 2.0 authentication.
User ID and Password
The basic user/password authentication.
The URL of the Salesforce server. Supported domains include
Server salesforce.com, force.com, and database.com. Defaults to
login.salesforce.com.
The Salesforce username. Available when the User ID and Password
HserD authentication type is selected.
Password The Salesforce password. Available when the User ID and Password
authentication type is selected.
The security token used to authenticate access to your Salesforce
_ account. Available when the User ID and Password authentication type is
i:i::ty selected. To generate a token, login to Salesforce, click the User Menu in
the top right corner, and select My Personal Information > Reset My
Security Token.
Refresh The Salesforce OAuth 2.0 token. Available when the OAuth 2.0
Token authentication type is selected.
Proxy Settings
TR The proxy hostname or IP address.
Server
Proxy Port |The proxy port.
Proxy User The proxy username.
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Proxy

Password

Advanced

Allow NULL
strings
Empty
strings as
NULL
Connection
Timeout
Include
Deleted

ODBC

Behavior

RegionalNu
mberSetting

S

The proxy password.

Settings

To retrieve metadata, not all parameters according to MSDN can accept a
null value. If NULL, the driver should return an error. But some 3rd-party
tools pass NULL to the parameters. These options should be enabled for

compatibility with such tools.

The time (in seconds) to wait for a connection to open before terminating
an attempt. The default value is 60.

Use the parameter to specify whether to include deleted records to the
query results. The default value is False.

Used to set the behavior corresponding to the ODBC specification
version that a third-party tool expects. The behavior of ODBC driver can
be changed by setting a value for the SQL_ATTR_ODBC_VERSION
attribute by calling the SQLSetEnvAttr function. But some third-party tools
expect the driver to exhibit ODBC 2.x behavior, but forget to call
SQLSetEnvAttr with the specified version or pass an incorrect value there.
In this case, the required behavior can be explicitly specified in the
Connection String by setting the ODBC Behavior parameter. The possible

values are:

® Default - default ODBC behavior determined by a third-party tool.
* Ver 2.x- ODBC 2.x behavior is explicitly set.
* Ver 3.x- ODBC 3.x behavior is explicitly set.

Enables the use of local regional settings when converting numbers to

strings.
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RegionalDat ] ) .
Enables the use of local regional settings when converting dates and
eTimeSettin | .
times to strings.
gs
Use the option to specify whether the driver must return foreign keys.
Retrieving metadata about foreign key constraints is a time-consuming
ReturnForei |operation; many third-party tools request foreign key metadata even whey
gnKeys they do not actually need this information. Note that enabling the option
may degrade performance of data access operations. The default value is
False.
Sets the string value types returned by the driver as Default, Ansi or

Unicode.

* Default - the driver defines the string types.

® Ansi - all string types will be returned as SQL_CHAR, SQL_VARCHAR
String Types, and SQL_LONGVARCHAR.

® Unicode - all string types will be returned as SQL_WCHAR,
SQL_WVARCHAR and SQL_WLONGVARCHAR.

The parameter value should be changed if any third-party tool supports
only Ansi string types or Unicode ones.
QueryTimeo The time to wait for a query execution result before terminating and
ut generating an error.
Specifies whether all the datetime values retrieved from the data source
are returned as UTC values or converted to local time and whether the
UTC Dates
date values specified on the application side (e.g., in SQL statements) are

considered UTC or local. The default value is false.

Salesforce ODBC Connection String sample

DRIVER={Devart ODBC Driver for Salesforce};User
ID=Your_uUsername;Password=***%*¥**.Saecurity
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Token=a6Lgob979Lw4anxfbhtDgtukr

© 2015-2024
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3.5 Using SOQL Queries

Using SOQL Queries with ODBC Driver

You can use the Salesforce Object Query Language (SOQL) with our ODBC driver to query
Salesforce data. SOQL is an optimized version of SQL specifically designed for accessing
the underlying Salesforce database. It doesn't support some of the SQL advanced features
like wildcards and joins, but allows using filters along with the SELECT clause to return an
optional set of data.

The main difference between SQL and SOQL is that the latter is intended exclusively for
querying the Salesforce database rather than modifying data with INSERT or UPDATE
statements. Also, traditional SQL is used for retrieving data from one or more tables, either
related or not, whereas SOQL is used for retrieving data only from Salesforce related objects.
The SELECT clause of a SOQL query doesn't allow the wildcard — you must mention all the
fields to select. Additionally, you must prefix the query with soqL: to make the ODBC driver
aware that you want to use the SOQL syntax, as in the following query.

SOQL: SELECT Contact.FirstName, Contact.Account.Name FROM Contact

Querying Salesforce Relationships

As mentioned earlier, SOQL doesn't support the JOIN keyword — instead it uses the parent-
to-child and child-to-parent relationships in Salesforce. Below are SQL and SOQL queries
which are equivalent.

[SQL]
SELECT Contact.Name, Contact.Email, Account.Name

FROM Contact
LEFT JOIN Account ON (Contact.AccountId = Account.Id)

[SOQL]

SOQL:SELECT Name, Email, Account.Name FROM Contact
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See Also
SOQL Reference
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Sandboxed Apps on macOS

Sandboxed Apps on macOS

Sandboxed applications don’t have permission to access iODBC Driver Manager on macOS.
This is caused by the System Integrity Protection (SIP) technology on macOS which protects
your files and folders from potentially malicious software by locking the application. When
accessing a data source from an application like Excel through the ODBC driver for

Salesforce, you may get an error message saying that the driver is unable to create a file.

Note that all third-party applications distributed through the Mac App Store are sandboxed.

Disabling System Integration Protection (SIP) on macOS

To resolve the issue, you should turn off SIP on your computer:

1. Restart your computer in Recovery mode (hold down Command + R until you see the
Apple logo).
2. Select Utilities > Terminal.

3. In the Terminal window, enter csrutil disable.

[ ] & Terminal — -bash — 80x 24

-bash-3.2# csrutil disable

Successfully disabled System Integrity Protection. Please restart the machine fo
r the changes tTo take effect.

-bash-3.2# rebootf]

4. Restart your computer.

5. Enter csrutil status to check the status of SIP.
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[ ] & f5} test — paserver — -bash — BOx24

tests—imac-2:~ test$ csrutil status
System Integrity Protection status: disabled.
tests-imac-2:~ testd [J

Enable SIP after you finish working with an ODBC data source. To turn on SIP, enter csrutil

enable and restart your computer.
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3.7 Enabling ODBC Tracing

Creating an ODBC Trace Log on Windows

When you start or stop tracing in the 64-bit ODBC Administrator, the tracing is also enabled
or disabled in the 32-bit ODBC Administrator, and vice versa.

If the ODBC client application you need to trace runs under Local System account or any
other user login than your own, select Machine-wide tracing for all user identities. For

example, this option may be necessary for SSMS.

To generate a trace file using ODBC Source Administrator on Windows, follow the steps
below.

1. Type obBC Data Sources in the Windows 10 search box (in earlier versions of Windows,
open Control Panel > Administrative Tools) and choose the application of the needed

bitness.

2. Select the Tracing tab.

w

. If necessary, change the default Log File path. Make sure that the path is writable by the
application, then click app1y.

. Click start Tracing Now.

. Restart all application processes.

. Click Test connection in the DSN settings to make sure the driver is able to connect.

N O o b~

. Reproduce the issue.
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8. Click stop Tracing Now on the Tracing tab.

9. Send us the obtained log file (for example, devart.log).

Creating an ODBC Trace Log on macOS

To enable the trace option on macOS, use the Tracing tab within ODBC Administrator.
1. Open the ODBC Administrator.

2. Select the Tracing tab.

3. If necessary, change the default Log file path.

4. Select A1l the time inthe when to trace option.

Creating an ODBC Trace Log on Linux

To trace the ODBC calls on Linux, set the Trace and TraceFile keyword/value pairs in the
[opBC] section of the /etc/odbcinst. ini file, for example:
[oDBC(C]

Trace=Yes
TraceFile=/home/test/devart.log

Make sure to disable logging after obtaining a log file since it affects the read/write speed.
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Supported Data Types

Data Type Mapping

The Devart ODBC Driver for Salesforce supports all Salesforce data types.

The following table describes how the Salesforce data types are mapped to the ODBC data
types.

Salesforce Data Types ODBC Data Types
ANYTYPE SQL_WVARCHAR
AUTONUMBER SQL_WVARCHAR
BINARY SQL_LONGVARBINARY
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CHECKBOX
COMBOBOX

DATACATEGORYGROUPREFERENCE

EMAIL
ENCRYPTEDTEXT
HTML

ID

INT
LONGTEXTAREA
MULTISELECTPICKLIST
NUMBER

PHONE

PICKLIST
REFERENCE
TEXTAREA

TIME

URL
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ODBC Forum
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3.9 Supported ODBC API Functions

Supported ODBC Functions

59

Provide Feedback

The SQLGetInfo function returns information about the driver and data source. To find out

whether a specific function is supported in the driver, call SQLGetFunctions.

For more information about the ODBC interface, see the ODBC Programmer's Reference.

ODBC Driver for Salesforce supports all deprecated functions for backward compatibility.
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The following table lists the currently supported ODBC functions.

Function Name Support Standard Purpose
Obtains an

environment,
SQLAllocHandle v ISO 92 connection,
statement, or

descriptor handle.

Connects to a
specific driver by

SQLConnect ' ISO 92 data source name,
user ID, and

password.

Connects to a
specific driver by
connection string or
_ requests that the
SQLDriverConnect v ODBC _

Driver Manager and
driver display
connection dialog

boxes for the user.
Obtains an

SQLAllocEnv v Deprecated environment handle
allocated from driver.
Obtains a

SQLAllocConnect v Deprecated
connection handle

ODBC API Calls for Obtaining Information about a Driver
and Data Source

Function Name Support Standard Purpose
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Returns the list of
SQLDataSources y S0 92 available data
sources, handled by
the Driver Manager
Returns the list of
installed drivers and
SQLDrivers ' ODBC their attributes,
handles by Driver
Manager
Returns information
SQLGetinfo y SO 92 abouta specific
driver and data
source.
Returns the functions
SQLGetFunctions v, ISO 92 supported by the
driver.
Returns information
SQLGetTypelnfo v, ISO 92 about supported

data types.

ODBC API Calls for Setting and Retrieving Driver

Attributes
Function Name Support Standard Purpose

Sets a connection
SQLSetConnectAttr v, ISO 92

attribute.

Returns the value of
SQLGetConnectAttr v, ISO 92 a connection

attribute.
SQLSetConnectOpti v Deprecated Sets a connection
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on

SQLGetConnectOpti

on

SQLSetEnvAttr

SQLGetEnvALttr

SQLSetStmtAttr

SQLGetStmtAttr

SQLSetStmtOption

SQLGetStmtOption

Deprecated

ISO 92

ISO 92

ISO 92

ISO 92

Deprecated

Deprecated

option

Returns the value of
a connection option
Sets an environment
attribute.

Returns the value of
an environment
attribute.

Sets a statement
attribute.

Returns the value of
a statement attribute.
Sets a statement
option

Returns the value of

a statement option

ODBC API Calls for Preparing SQL Requests

Function Name

SQLAllocStmt

SQLPrepare

SQLBindParameter

SQLGetCursorNam

e

Standard

Deprecated

ISO 92

ODBC

ISO 92

Purpose
Allocates a

statement handle
Prepares an SQL
statement for later
execution.

Assigns storage for
a parameterinan
SQL statement.

Returns the cursor

name associated
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with a statement

handle.
SQLSetCursorNam Specifies a cursor
v ISO 92
e name.
. Sets options that
SQLSetScrollOption
v OoDBC control cursor
S
behavior.

ODBC API Calls for Submitting Requests

Function Name Support Standard Purpose

Executes a prepared
SQLExecute ./ ISO 92

statement.

_ Executes a
SQLExecDirect v ISO 92

statement

Returns the text of an
, SQL statement as
SQLNativeSq| ./ ODBC
translated by the
driver.
Returns the
_ description for a
SQLDescribeParam v ODBC
specific parameter
in a statement.
Returns the number
SQLNumParams v ISO 92 of parameters ina

statement.

Used in conjunction

with SQLPutData to
SQLParamData v, ISO 92

supply parameter

data at execution
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SQLPutData

ISO 92

time. (Useful for long
data values.)

Sends part or all of a
data value for a
parameter. (Useful

for long data values.)

ODBC API Calls for Retrieving Results and Information

about Results

Function Name

SQLRowCount

SQLNumResultCols

SQLDescribeCol

SQLColAttribute

SQLColAttributes

SQLFetch

SQLFetchScroll

Standard

ISO 92

ISO 92

ISO 92

ISO 92

Deprecated

ISO 92

ISO 92

Purpose
Returns the number

of rows affected by
aninsert, update, or
delete request.
Returns the number
of columns in the
result set.
Describes a column
in the result set.
Describes attributes
of a column in the
result set.
Describes attributes
of a column in the
result set.

Returns multiple
result rows.

Returns scrollable

result rows.
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Returns scrollable
SQLExtendedFetch v Deprecated I
result rows.

Positions a cursor
within a fetched
block of data and
enables an
SQLSetPos v ODBC
application to refresh
data in the rowset or
to update or delete
data in the result set.
Performs bulk
insertions and bulk
. bookmark
SQLBulkOperations ./ ODBC
operations, including
update, delete, and

fetch by bookmark.

ODBC API Calls for Retrieving Error or Diagnostic

Information
Function Name Support Standard Purpose
Returns additional
SQLError v Deprecated error or status
information
Returns additional
diagnostic
o information (a single
SQLGetDiagField v ISO 92

field of the
diagnostic data

structure).
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Returns additional
diagnostic
information (multiple
fields of the

diagnostic data

SQLGetDiagRec v ISO 92

structure).

ODBC API Calls for Obtaining Information About
Database Objects (Catalog Functions)

Function Name Support Standard Purpose
Returns a list of

o columns and
SQLColumnPrivileg

es

v, ODBC associated
privileges for one or
more tables.
Returns the list of

SQLColumns v X/Open column names in
specified tables.
Returns a list of
column names that
SQLForeignKeys v ODBC make up foreign
keys, if they exist for
a specified table.
Returns the list of
SQLPrimaryKeys v ODBC column names tha
make up the primary
key for a table.
SQLProcedureColu Returns the list of

' oDBC _
mns input and output
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parameters, as well
as the columns that
constitute the result
set for the specified
procedures.
Returns the list of
SQLProcedures v OoDBC procedure names
stored in a specific
data source.
Returns information
about the optimal set
of columns that
uniquely identifies a
row in a specified
SQLSpecialColumn table, or the columns
' X/Open
s that are
automatically
updated when any
value inthe row is
updated by a
transaction.
Returns statistics
about a single table
SQL Statistics ' ISO 92 and the list of
indexes associated
with the table.

Returns a list of
SQLTablePrivileges v ODBC tables and the

privileges
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SQLTables v X/Open

associated with
each table.

Returns the list of
table names stored
in a specific data

source.

ODBC API Calls for Performing Transactions

Function Name Support Standard
SQLTransact v Deprecated
SQLENndTran v, ISO 92

Purpose
Commits or rolls

back a transaction
Commits or rolls

back a transaction.

ODBC API Calls for Terminating a Statement

Function Name Support Standard
SQLFreeStmt v ISO 92
SQLCloseCursor v, ISO 92
SQLCancel v ISO 92

Purpose
Ends statement

processing, discards
pending results, and,
optionally, frees all
resources
associated with the
statement handle.
Closes a cursor that
has been opened on
a statement handle.
Cancels an SQL

statement.
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ODBC API Calls for Terminating a Connection

Function Name Support

Standard

ISO 92

ISO 92

Deprecated

Deprecated

ODBC Forum

Purpose
Closes the

connection.

Releases an
environment,
connection,

statement, or

descriptor handle.

Releases connection

handle.

Releases an

environment handle.

Provide Feedback

SQLDisconnect '
SQLFreeHandle v
SQLFreeConnect v,
SQLFreeEnv v
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4 Using in Third-Party Tools

This section discusses how to use ODBC Driver for Salesforce with ODBC-compliant tools.

e DBeaver
e DBxtra

e Oracle Database Link

e Microsoft Access

e Microsoft Excel

¢ OpenOffice and LibreOffice

e PHP
e Power Bl

e Python
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¢ QlikView

e SQL Server Management Studio

e SSIS

e Tableau
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Using in DBeaver

DBeaver Overview

DBeaver is a free, open source multiplatform database management tool and SQL client for
developers and database administrators. DBeaver can be used to access any database or
cloud application that has an ODBC or JDBC driver, such as Oracle, SQL Server, MySQl,
Salesforce, or Mailchimp. Devart DBeaver provides you with the most important features
you'd need when working with a database in a GUI tool, such as:

e SQL queries execution

¢ Metadata browsing and editing
e SQL scripts management

e Data export/import

e Data backup

e DDL generation

¢ ER diagrams rendering

e Test data generation

e BLOB/CLOB support

¢ Database objects browsing

e Scrollable resultsets

The tool comes in two editions — Community and Enterprise. Enterprise Edition supports
NoSQL databases, such as MongoDB or Cassandra, persistent query manager database,
SSH tunneling, vector graphics (SVG) and a few other enterprise-level features. Note though
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that you can access a MongoDB database from DBeaver Community Edition using the
respective Devart ODBC driver. For the purposes of this guide, we'll use the Community
Edition of DBeaver to retrieve data from Salesforce via the Open Database Connectivity
driver.

Creating an ODBC Data Source to Use Salesforce Data
in DBeaver

1. Click the Start menu and select Control Panel.

2. Select Administrative Tools, then click ODBC Data Sources.

3. Click on the System DSN tab if you want to set up a DSN name for all users of the system
or select User DSN to configure DSN only for your account.

4. Click the Add button and double-click Devart ODBC Driver for Salesforce in the list.

5. Give a name to your data source and set up the connection parameters.

6. Click the Test Connection button to verify that you have properly configured the DSN.

When using ODBC driver for Salesforce with DBeaver, SQL_WVARCHAR data types may
be displayed incorrectly in DBeaver. To prevent this, you need to set the string data types to
Ansi either in the Advanced Settings tab of the driver configuration dialog or directly in the
connection string (String Types=Ansi) — all string types will be returned as SQL_CHAR,
SQL_VARCHAR and SQL_LONGVARCHAR.

© 2024 Enter your company name



72

ODBC Driver for Salesforce

Devart ODBC Driver Configuration
General Advanced settings  |icense About
Meta Data
- - - - -
Connection
-
L
Compatibility
ODBC Behavior Default hd
String Types Ansi (SQL_CHAR, SQL_VARCHAR, SQL_LONE
Use Local Regional Settings when converting to string
[ ] Mumbers [ ]Dates and times
Test Connection

Connecting to Salesforce Data from DBeaver via ODBC

Driver for Salesforce

Follow the steps below to establish a connection to Salesforce in DBeaver.

1. In the Database menu, select New Database Connection.
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Yy DBeaver 6.1.5

Eile Edit Mavigate Search SOL Editor | Database Window Help

¢ | 9 | 7 I3 i 4 + % NewDatabase Connection
L]

_ ) =% Driver Manager
f® Database Mavigator i3 | [F Projects

¥ Connect

Invalidate/Reconnect
Enter a part of table name here

QODEC - xBase_xbd

Change Connection(s) Driver
ODBC - ZohoCRM_x64

&, ODBC - MailChimp_x64 Pisconned

£ ODBC - MongoDB_x64 Disconnect All

= ODBC - Oracle x64 20 compare/Migrate >
= ODBC - salesforceMC_x64 3 Tools ,
= ODEC - SugarCRM_x64 Context tools Al

2. In the Connect to database wizard, select ODBC and click Next.

fw Connect to database O >

(1

Select your database
ODBC bridge driver

Type part of database/driver name to filter & Gallery

Mame # ~
= ODBC 7
& Apache Ignite
5 AwWS
A Azure

3. Enter the previously configured DSN in the Database/Schema field.
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& stabase O
Generic JDBC Connection Settings
. : = 0DBC
ODBC connection settings
General Driver properties SSH Proxy
JDBEC URL: ‘jdbc:Odbc:DBEAVER_DATASOURCE
Database/Schema: | DBEAVER_DATASOURCE |
User name: ‘ |
Passward: ‘ | Save password locally

4. Click Test Connection. If everything goes well, you'll see the Success message.

Viewing Salesforce Database Objects and Querying Data

You can expand out the database structure in DBeaver's Database Navigator to visualize all
the tables in Salesforce database. To view and edit the data in a table, you need to right-click
on the target table name and select View data.The content of the table will be displayed in the
main workspace.

ry DBeaver 6.1.5 - Solution
File Edit Mavigate Search SOLEditor Database Window Help
¢~ Ve |05 Tl ato |-

{= Databa.. 2 |[E@Projecs = O BB solution &2

- = = ¥ . .
A | = F® properties | [} Data | 57 ER Diagram = ODB
Enter a part of table name here ~

FB siteDetail A | |BBsolution |vy
AR SiteFeed T solutionMame T3+ IsPublished
B SiteHistory I - —
B Sitelf rbwh't st i 1 GC1020 Portable Generator Switch Malfunctioning true

itelframeWhiteListUr] — : .
m Soluti 2 Generator assembly instructions unclear false

olution —
M Solufionfesd % 3 Maintenance guidelines for generator unclear false
M SolutionHistory [; 4 | Selecting the Right Generator for Your Meeds true
EP Solutionstatus T s GC3000 Series Propane Generator Ignition true
B Stamp & | Starting generator after electrical failure false
BB StampAssignment 7 | Electrical wiring installation for GC5060 false
P StaticResaurce g GenWatt SLA Commitments true

If you want to write a custom SQL query that will include only the necessary columns from the
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table, you can select New SQL Editor in the SQL Editor main menu. Create your query and

run it by clicking Execute SQL Statement to view the results in the same window.

= Databa.. 2 Projects = B | [T *<ODBC - salesforce_xf4> Script-5 52
“_ e | - = b SELECT SolutionMame, SolutionNote FROM Solution;
Enter a part of table name here b,
BB SiteDetail ~ eT
FB SiteFeed = e
BB siteHistory B solution &2
B sitelframeWhiteListUrl :
E «T SELECT SolutionMame, Solt | &4
FH solution
E® SolutionFeed = SolutionMame T SolutionMote
= = (] - -
A8 SolutionHistory | | If the generator switch i:
B8 SolutionStatus 2 | Generator assembly instructions unclear  The Maintenance Manu:
EB Stamp % 3 | Maintenance guidelines for generator uncle The Maintenance Manu:
- = —] . . .
£8 StampAssignment . 4 | Selecting the Right Generator for Your Nee GenWatt offers a wide r
= StatlcR§source T s GC3000 Series Propane Generator Ignition The GC3000 series prog
: Stream!ngchannel & | Starting generator after electrical failure  After an electical failure,
= Stt;earr:ng.channelshare 7 | Electrical wiring installation for GC5060 The red wiring from the
TabDefinition — . .
i g GenWatt SLA Commitments GenWatt offers four diff
FB TabledVerify_ChangeEve — . .
( N = Electronic panel fitting loose On the GC3020, the elec
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4.2 Using in Oracle DBLink

Configuring Oracle Database Gateway for ODBC

This article explains how to configure Oracle Database Gateway for ODBC. If your data is
stored in a non-Oracle database system or cloud application, and you need to access it from
an Oracle Database server, you can create a database link to an Oracle Database Gateway
for ODBC. The gateway works with an ODBC driver to access non-Oracle systems or other,
remote Oracle servers. Any ODBC-compatible data source can be accessed using the
gateway and the appropriate ODBC driver. The driver must be installed on the same machine
as the gateway. The non-Oracle system can run on the same machine as the Oracle server
or on a different machine. The gateway can be installed on the machine running the non-
Oracle system, the machine running the Oracle database or on a third machine as a
standalone.
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Configure the Initialization File

After installing the gateway and the ODBC driver for Salesforce, create an initialization file for

your Oracle Database Gateway for ODBC. The sample file initdg4odbc.ora is stored in the
ORACLE_HOME\hs\admin directory. To create an initialization file for the gateway, copy the
sample initialization file and rename it. The name must be prefixed with init — for example,
initSalesforce.ora. YOu need a separate initialization file for each ODBC data source. After
creating the file, set the Hs_Fps_conNecT_1INFo parameter to the system DSN that you created
earlier, for example:

HS_FDS_CONNECT_INFO=Salesforce

Configure Oracle Net Listener

After configuring the gateway, you need to configure Oracle Net Listener to communicate with
the Oracle database. Information about the gateway must be added to the 1istener.ora
configuration file which is located in the orAcLE_HoME \NETWORK\ADMIN\ directory. The following
example is the address on which the Oracle Net Listener listens (HosT is the address of the
machine on which the gateway is installed):
LISTENER =

(DESCRIPTION_LIST =

(DESCRIPTION =
(ADDRESS = (PROTOCOL = TCP) (HOST = Tocalhost) (PORT = 1521))

)

Add an entry to the 1istener.ora file to start the gateway in response to connection requests.
The SID of the gateway (s1p_Name) must be the same in listener.ora and tnsnames.ora.
ORACLE_HOME is the Oracle home directory where the gateway resides. To apply the new
settings, stop and restart the Oracle Net Listener service.
SID_LIST_LISTENER=
(SID_LIST=
(SID_DESC=

(SID_NAME=Salesforce)

(ORACLE_HOME=D: \ORACLE_HOME)

(PROGRAM=dg4odbc)

)
)

Configure Oracle for Gateway Access

Add a connect descriptor for the gateway to the tnsnames.ora file, which is located in
ORACLE_HOME \NETWORK\ADMIN directory. The sip must match the value specified in the
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listener.ora file.

Salesforce =
(DESCRIPTION =
(ADDRESS = (PROTOCOL = tcp) (HOST = 1oca1host) (PORT = 1521))
(CONNECT_DATA =
(SID = Salesforce)

)
(HS = 0OK)

Create Database Links

To access an ODBC data source, you must create a database link using a database tool like

SQL Plus or dbForge Studio for Oracle: connect to your database server and execute the

CREATE DATABASE LINK statement, as follows:

CREATE DATABASE LINK dblink CONNECT TO "username" IDENTIFIED BY "password"

dblink is the complete database link name. tns_name_entry is the Oracle Net connect
descriptor specified in the tnsnames.ora file.

When you create the database link in dbForge Studio for Oracle, you can see your newly

created link in Database Links on the left panel. After creating the database link, you can run a
query against the ODBC data source using the following syntax:

SELECT * FROM table_name@"dblink_name"

See also

Configuring Oracle Database Gateway for ODBC
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4.3 Usingin DBxtra

Troubleshooting Salesforce ODBC Connection in DBxtra

This page explains how to troubleshoot your ODBC connection to Salesforce in DBxtra.

Due to incompatibilities between DBxtra and Salesforce, leaving the sqQL dialect property to
its default might present various issues. To resolve compatibility issues, set the property to ms
Access 2000/XP/2003 or ANSI sqQL/20e3 for DBxtra version 11.0.1 or newer, and to ANSI
sqL/2ee3 for versions prior to 11.0.1.
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Connect through ODBC E3
MNOTE:
Imiportant!
Due to incompatibles, selecting the Auto SQL dialect might present various
problems using the Auto SCL dialect with some database servers.
Please be sure to select the right SQL dialect for your connection.
Connection name |MyData
Data source |DataSource 1 III
User
Password
Connection timeout 15 : S0L dialect || M5 Access 20000 |w
Enable Offline Mode
Get columns descriptions
Select User Groups who can view this Connection
] accounting A
[]contraling
Guest Group
[~ILegal
Management
[#IManufacturing
[#Marketing
[Purchasing W
Select Al Unselect Al Cancel
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44 Using in Microsoft Access

Connecting Microsoft Access to Salesforce Using an
ODBC Driver

This article explains how to connect Microsoft Access to Salesforce through the standard
ODBC interface. Microsoft Access is a dababase management system that combines the
relational database engine with a graphical user interface. Access can be used as a
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substitution for spreadsheet applications like Excel to organize, store, and retrieve large
amounts of related data that can be difficult to manage in spreadsheets.

In Microsoft Access, you can connect to your Salesforce data either by importing it or creating
a table that links to the data. Devart ODBC drivers support all modern versions of Access. It
is assumed that you have already installed and configured a DSN for ODBC driver for
Salesforce. For the purpose of this article, we tested an ODBC connection to Salesforce
through our ODBC drivers in Microsoft Access 2003, Microsoft Access 2007, Microsoft
Access 2010, Microsoft Access 2013, Microsoft Access 2016, Microsoft Access 2019. The
following steps describe how to use Microsoft Access 2019 to import or link to your data in

Salesforce.

Importing Salesforce Data Into Microsoft Access Through an ODBC
Connection
1. Open your Microsoft Access database.

2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select

ODBC Dababase.

4. In the Get External Data - ODBC Database dialog box, select Import the source data

into a new table in the curent database, and click OK.
. In the Select Data Source dialog box, select the Machine Data Source tab.
. Select the DSN that you have configured for Salesforce and click OK.

. In the Import Objects dialog box, select the tables that you want to import, and click OK.

0 N O O

. If the database objects have been successfully imported, you should the see the
corresponding message in the dialog box. If you want to save the import steps to quickly
repeat the process without using the wizard at a later time, select the Save import steps

checkbox. Click Close.
9. The imported tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.

Linking to Salesforce Data in Microsoft Access Through an ODBC
Connection
1. Open your Microsoft Access database.
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4.5

2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select
ODBC Dababase.

4. In the Get External Data - ODBC Database dialog box, select Link to the data source
by creating a linked table.

5. In the Select Data Source dialog box, select the Machine Data Source tab.

6. Select the DSN that you have configured for Salesforce and click OK.

7. In the Link Tables dialog box, select the table or tables that you want to link to, and click
OK.

8. The Select Unique Record Identifier dialog box will prompt you to choose a field or fields
that uniquely identify each record in the table. To avoid inconsistencies, it is recommended
to select the primary key in the Salesforce table as the unique record identifier. You are

linking multiple tables, you will be prompted to select unique record identifiers for each of

the selected tables.
9. The linked tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.
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Using in Microsoft Excel

Connecting to Salesforce from Microsoft Excel using
ODBC Driver for Salesforce

You can use Microsoft Excel to access data from a Salesforce database using ODBC
connector. With ODBC Driver, you can import the data directly into an Excel Spreadsheet
and present it as a table. Make sure that you use matching Excel and ODBC Diriver, e.qg. if
you have installed a 64-bit ODBC Driver, you will need to use the 64-bit version of Excel.

When working with Microsoft Excel, there are different ways of retrieving data from various
data sources using our ODBC drivers.

e Connecting Excel to Salesforce with Get & Transform (Power Query)
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e Connecting Excel to Salesforce with Data Connection Wizard (Legacy Wizard)

e Connecting Excel to Salesforce with the Query Wizard

e Connecting Excel to Salesforce with Microsoft Query

e Connecting Excel to Salesforce with PowerPivot

Connecting Excel to Salesforce with Get & Transform
(Power Query)

You can use Get & Transform (Power Query) to connect to Salesforce from Excel with
ODBC. This method assumes that you've installed an ODBC driver for Salesforce.

1. Click the Data in Excel, then expand the Get Data drop-down list. Click From Other

Sources > From ODBC.

H Bookl - Excel Evgeniy Lemeshov 2| |
File Home Insert Page Layout Formulas Review View Help @ Tell me 9 Share
(& [& |_ e A [Z1A ~ [E Be g g
= IR AR EREIE
=1 [ - .
Get Refrash z| Sort Filter Text to What-If Forecast Outline
B = Y, = - B -
Data - All - i Columns =2 Analysis = Sheet M
Gi Sort & Filter Data Tools Forecast L
ﬁ From File L
c b
Ty
From Database L ~ - - - ' ' ; =
— 1 3
Ay m - | + 100%
= am From Azure 4 From Table/Range
L=y
__E) From Online Services » _@ From Web
B =
_.¢. From Qther Sources L4 _ From Microsoft Query
B
\_)r"j Combine Queries 4 _.¢. From QDEC

2. In the From ODBC dialog, choose your data source name (DSN). If you haven't configured
your ODBC driver yet, you can expand the Advanced Options dialog box and enter the

connection string for your data source (without credentials, which are defined in the
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credentials dialog box in the next step). Additionally, you can enter an SQL statement that

will be executed right after establishing a connection to the data source. Click OK.

From ODBC

Data source name (DSN)

| Devart ODBC Dniver b

4 Advanced options
Connection string (non-credential properties) (optional) &

501 statement (optional)
SELECT * FROM MyDatabase.MyTable;

Supported row reduction clauses (optional)
(Mone) = Detect

3. If you're using a database username or password, select Database and enter your

credentials in the dialox bog, then click Connect.
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ODBC driver X
Default or Custom < dsn=Devart ODBC Driver
. Use a username and password to access a data source with an ODEBC driver,

Windows

User name
Database myusername

Password

SR NeREeE

Credential connection string properties (optional) (0

Back Cancel

If your database is not password-protected or you've already specified your credentials in the
ODBC data source settings, select Default or Custom and press Connect

Default or Custom ¢'d5”: evart ODBC Driver

Wind Don't specify any credentials or only connection string properties.
indows

Credential connection string properties (optional) (O
Database

Back Cancel

4. In the window that appears, select the table you want to retrieve data from, and click Load.
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O X
Navigator
yel

Select multiple items
Display Options ~ Dﬂ
4 F ODBC (dsn=0DBC Driver for 5... A

] AcceptedEventRelation . .

? No item selected for preview

B Account

B AccountChangeEvent

B AccountCleaninfo

B AccountContactRole

B AccountContactRoleChange...
Select Related Tables load |~ Edit Cancel

The data from the table will be a displayed in an Excel spreadsheet where you can further
work with it.

H ©- Book1 - Excel Table... = = = x

File Home | Insert | Page La| Formul: | Data | Review | View | Design |  Tell me.. Evgeniy.. S Share
g g genty.

Al - f;r w
D E F G H -

1N SolutionName ﬂ IsPuhIishEdn IsPuhIisI’ﬂ Status ﬂ IsReuiewedﬂ §

2 |GC1020 Portable Generator Switch Malfunctioning 1 0 Reviewed 11

3 |Generator assembly instructions unclear 1] 0 Draft [

4 |Maintenance guidelines for generator unclear 1] 0 Draft 0T

5 |Selecting the Right Generator for Your Needs 1 0 Reviewed 1/d

6 |GC3000 Series Propane Generator Ignition 1 0 Reviewed 1T

7 |Starting generator after electrical failure 1] 0 Draft o n

8 |Electrical wiring installation for GC5060 1] 0 Draft 0T

9 |GenWatt SLA Commitments 1 0 Reviewed 1/

10 |Electronic panel fitting loose 0 0 Draft 0 C

Sheet1 ) 1 »

Connecting Excel to Salesforce with Data Connection
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Wizard (Legacy Wizard)

You can use this option to connect to OLE DB or ODBC external data source that has
already been defined.

1. In Excel, go to the Data tab. Click From Other Sources, and then click From Data

Connection Wizard.
2. In the opened dialog, select ODBC DSN and click Next to continue.
3. Now select a data source you want to connect to, and click Next.

4. To connect to the table containing the required data, select its name and click Next to enter

and save information about your new file or click Finish.

5. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

6. The required data is now displayed in the existing Excel worksheet.

Connecting Excel to Salesforce with the Query Wizard

You can use this option to create a simple query for retrieving data from Salesforce to Excel
via ODBC driver.

1. Open Excel, in the main menu, click the Data tab.
2. Click the From Other Sources dropdown menu, and then click From Microsoft Query.
3. In the appeared dialog, you can choose the data source you want to connect to.

4. After a successful connection, you can select the data you want to be displayed in Excel

and click Next.
. The next two steps allow filtering and sorting the data. Click Next to skip these procedures.
. If you plan to further use the query, you can save it by clicking the Save button on the right.

. Select Return Data To Microsoft Excel and click Finish.

0 N O O

. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

9. The required data is successfully imported to Excel.

Connecting Excel to Salesforce with Microsoft Query
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You can use this option to create a more complex query for retrieving Salesforce data to
Excel via ODBC driver.

1.
2.
3.

Start Excel, click the Data tab.
In the appeared ribbon, click From Other Sources, and then click From Microsoft Query.

In the next dialog, choose the data source you want to connect to (e.g., using data source
name - Devart ODBC Salesforce). Uncheck Use the Query Wizard to Create/Edit

Queries and click OK.

. Now you can select the tables you want to add to your query. When you finish, just click

the Add button.

. In the graphical editor, you can filter rows or columns of data, sort data, join multiple tables,

create a parameter query, etc.

Connecting Excel to Salesforce with PowerPivot

You can use PowerPivot - an Excel add-in to perform data analysis and create complex data

models. To load the required data, do the following:

1

. In Excel, click the PowerPivot tab, then click Manage to go to the PowerPivot window.
. In the opened window, click From Other Sources.

2
3.
4
5

When the Table Import Wizard opens, select Others (OLEDB/ODBC) and click Next.

. In the Specify a Connection String window, click the Build button.

. In the Data Link Properties dialog, specify the data source you want to connect (e.g.,

using data source name - Devart ODBC Salesforce), and then click Next.

. Now you should choose how to import the data (either select a table from the list or write a

query to specify the data to be imported).

. When the Import operation succeeded, click the Close button. The retrieved data is

inserted in the active worksheet.

© 2015-2024
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4.6

461

Using in SQL Server Management Studio

This section describes how to establish and troubleshoot a connection to Salesforce from
SQL Server Management Studio using ODBC Driver for Salesforce.

¢ Creating a Linked Server

¢ Troubleshooting in SSMS

© 2015-2024
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Creating a Linked Server

Requirements
In order to avoid incorrect integration with MS SSMS, the working environment must meet the
following conditions:

¢ The data source must be a configured system DSN. Refer to the Driver Configuration

article to learn how to configure a System DSN

e The driver, studio, and SQL Server must be of the same bitness. For example, if you are
using 64-bit SQL Server Management Studio on 64-bit Windows platform, then configure
the 64-bit version of the driver using ODBC Administrator launched from %windir%
\system32\odbcad32.exe. Otherwise, configure the driver using the 32-bit version of ODBC
Administrator - launch it from %windir%\SysW OW64\odbcad32.exe.

e ODBC Diriver for Salesforce and SQL Server must be installed on the same computer.

e NET Framework 4.5 must be installed on the computer.

Connecting to Salesforce from SQL Server Management
Studio using ODBC Driver for Salesforce

You can use the Microsoft SQL Server Management Studio to connect your Salesforce data
to an SQL Server instance. Linked Server is a tool of MS SQL Server that allows to execute
distributed queries to refer tables stored on non-SQL Server datbase in a single query. With
linked servers, you can execute commands against different data sources such as

Salesforce and merge them with your SQL Server database. You can create a linked server
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with one of these methods: by using the options in the Object Explorer or by executing stored
procedures.

Below are major advantages of using SQL Server Linked Servers to connect to Salesforce:
1. The ability to connect other database instances on the same or remote server.

2. The ability to run distributed queries on heterogeneous data sources across the

organization.

3. The ability to work with diverse data sources in the same way.

How to configure a SQL Server Linked Server to connect
to Salesforce

You can follow the steps to create a linked server for Salesforce in SQL Server Management
Studio by using Object Explorer:

1. Start your Management Studio and choose your SQL Server instance.
2. In the Object Explorer pane, expand the Server Objects, right-click on Linked Servers

and then click on New Linked Server.

3. Configure your linked server in the dialog box:
¢ Give a name for your server in the Linked server field.
e Under Server type, select Other data source .

e Choose Microsoft OLE DB Provider for ODBC Drivers in the Provider drop-down
list.
¢ |n the Data source field, enter the name of your DSN, e.g. Devart ODBC Driver for

Salesforce . Alternatively, you can input the ODBC Driver connection string in the

Provider field.

The linked server will appear under the Linked Servers in the Object Explorer Pane. You can
now issue distributed queries and access Salesforce databases through SQL Server.

Retrieving Data From Salesforce

Ensure the Allow inprocess option of MSDASQL OLE DB Provider for ODBC Drivers is
enabled. For this, find the MSDASQL provider in the list of Linked Servers and double-click on
it
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Object Explorer * I x
Connect~ ¥ *¥ (VI
= @ EVGEMIYL\SQLEXPRESS (SOL Server 14.0.1000 - C
Databases
Security
= Server Objects
Backup Devices
= Linked Servers
B Providers
@8 ADsDSOObject
wE MSDAOQSP
wh MSDASQL
wh MSOLAP
wE MSOLEDBSQL
wh search.CollatorDs0O

In the appeared Provider Options window, enable the Allow inprocess checkbox:

@E Provider Options - Microsoft OLE DB Provider for ODBC Drivers — O
e e IT Script « ﬂ Help
& General

Provider options:

Enable MName

U
U
[]

[Cynamic parameter
MNested queries
Level zero only
Allow inprocess

Maon transacted updates
Index as access path
Disallow adhoc access
Supports "Like’ operator

Lienlemed mmmamen s amimem dhin messicd e

Create a new Linked Server
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Object Explorer
Connect~ ¥ ¥ G »

rrll-}{

= @ EVGENIYL\SQLEXPRESS (SQL Server 14.0.1000 - DATASOFT

Databases

Security

= Server Objects
Backup Devices

c

Providers ( Mew Linked Server...

Triggers Start PowerShell

Replication
PalyBase Reports '
Management Refresh

HEvent Profiler

£

Make sure to select Microsoft OLE DB Provider for ODBC Drivers:

H New Linked Server = O *
# General
& Security
& Server Options b
Server type:
() 5QL Server
(®) Other data source
Pravider: Microsaft OLE DB Provider far ODBC Drivers w
Product name: | |
Data source: | |
Provider string: | |
Location | |
Catalog | |

Connechon

Now you need to input the Linked Server name, e.g. SALESFORCE. In the Product Name
and Data Source fields you need to indicate the System DSN that you've previously created -

more info on System DSN setup can be found here.
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4 New Linked server

Select a page IT Scipt ~ ) Help
& General
& Security
& Server Options Linked server:
Server type:
() 5QL Server
(®) Other data source
Provider:
Product name:
Data source:
Provider string:
Location
Catalog
Connection
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Microsoft OLE DB Provider for ODBC Drivers

| Devart ODBC Driver for Salesforce

|Salesfnrce

The Salesforce tables are already available to be fetched. To query the linked server, click

New Query in the toolbar:

File Edit View Project SOL Complete

Tools  Windoy

P |i*.3' -2 d'"H%]NewEluer}r = & &A

| Execute

Object Explaorer
Connect~ ¥ ¥ ¢ »

> I x

= ¥ EVGENIYL\SQLEXPRESS (SQL Server 14.0.1000 - DATASOFT

Databases

Security

= Server Objects
Backup Devices
:
Providers

H ORACLE

B rPosSTGRESQOL

B saute

BEEEE

Enter your SQL query in the editor window and click Execute to run the query:
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LQ SQLQueryl.sql - EVGENIYL\SQLEXPRESS.master (sa (54))* - Microsoft SQL Server Management St..  CQuick Launch (Ctrl+Q) P = 0O x
File Edit View Query Project SOL Complete Tools Window Help
oo |d oM Brewaey AR QRO XEA|2-0 (B Cme
5% % | master - | b Execute Vv ES | =Tl m’%mrj | = %= |=3=|%.
— —
objec Exlorer YT ——————
. B o S|SELECT * FROM [SALESFORCE]...[Solution]; +
Connect~ ¥ ¥ G ~
B macenTo " 1
B maiLcHime
B monGoDs -
8 ms saL SERVER 100% -~
B mvsal B Resuts 2 Messages
5 MNETSUITE SolutionName lsPublished  IsPublishedinPublickb  Status IsRe
5 QORACLE 1 GC1020 Portable Generator Switch Malfunctioning 1 0 Reviewed 1
5 POSTGRESQL 2 Generator assembly instructions unclear 0 0 Diraft 0
5 QUICKEQOKS 3 Maintenance guidelines for generator unclear 0 0 Diraft 0
= B SALESFORCE 4 Selecting the Right Generator for Your Needs 1 0 Reviewed 1
=] Catalogs 5 GC3000 Series Propane Generator Ignition 1 0 Reviewed 1
System Catalogs & Starting generator after electrical failure o o Draft o
a default 7 Blectrical wiring installation for GC5060 0 0 Drraft 0
B sql AZURE 8 GenWatt SLA Commitments 1 o Reviewed 1
:q SQLITE 15'D Eecf:niclpanilf:rﬂingsloo.se 1D E Eraﬂ - 1D
5 SUGARCRM enWatt Installation Services Eviewe:
B xease
5 zoHoCRM
Triggers v >
< > 0 Query execut.. | EVGEMIYL\SQLEXPRESS (14.0 RTM} | sa (54) | master | 00:00:10 | 10 rows
As a result, you can see the contents of the selected table retrieved directly from the
Salesforce account you are connected to.
¢ Troubleshooting SSMS
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

46.2 Troubleshootingin SSMS

When creating a linked server in SSMS, most errors happen due to security issues with
DCOM class MSDAINITIALIZE. We need to alter the DCOM Class MSDAINITIALIZE security
settings to make it work.

Following are the steps:

1. Open Component Services (Start>Run>DCOMCNFG)

2. Expand Component Services>Computers>My Computer>DCOM Config

3. From the list of DCOM components on the right side, select MSDAINITIALIZE and go to its
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properties:

-
%. Component Services

. File Action

View Window Help

Console Root
4 . Component Services
a [ Computers
4 (& My Computer
» [ COM+ Applicatio
1 (] DCOM Config
& [ -] Running Processe
p 7] Distributed Trans:
I E Ewvent Viewer (Local)
3 f.a Services (Local)

Windows... Windows R... Windows R...
Microsoft Microsoft Microsoft Microsoft
Windo... Windows ...  WMIPro.. WMIProvi...

¥ & & @&

Micrasoft... Microsoft.L.. MicroseftV... Microsoft..

ApplD
MMC ALY MSMDPP - MsRdpbess...
Applicati... LIZE

¥ ¥ & @

MSTTS Mahimicse.. MAP Agent Map Elevated
DecObj Cla... Service COM class
NCLUA MDFAPI netman netprofm

¥ ¥ & @

MetProjW  Metwork and  Offline Files  OpenSearch
Sharing Ce... Service Description...

More Actions 4

4. Go to the Security Tab, Choose ‘Customize’ and click on the ‘Edit’ Button:
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MSDAINITIALIZE Properties

| General | Location | Securty | Endpoirts | Idertity |

Launch and Activation Permissions
(71 Use Default

i@ Customize

Access Permissions

(71 Use Default

i@ Customize

Corfiguration Pemissions
(71 Use Default

i@ Customize

Leam more about setting these properties.

[T | e——

5. Add the Domain User who is accessing the linked server and ‘Allow’ all the permissions

available (Local Launch, Remote Launch, Local Activation, Remote Activation). If you are

connecting to SQL server using SQL account, you need to provide this permission to the

account under which the SQL service is running.

6. Do this for all the 3 sections in the above screenshot.

To edit the Security settings, we followed the below steps:

1. Start > Run > Regedit

2. Find the Key: HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppID\{2206CDB0-19C1-

11D1-89E0-00C04FD7A829}

© 2024 Enter your company name



Using in Third-Party Tools 95

3. Right Click>Permissions>Advanced>Owner Tab:

-

. _ N
. Advanced Security Settings for {2206CDB0-19C1-11D1-89E0-00C04FD7AB29} S

sgiii

Pemissions I Auditing | Owiner | Effective Permissions

You can take or assign ownership of this object f you have the required permigsions or privileges.

Current owner:

< - s i = iy et o -

Change ownerta:

Name

Cither users or groups...

[7] Beplace owner on subcontainers and objects

e e e o P A At
SRRRRRRRATY

Leam about ohject ownership

. R e e r oy T R R PP 0.

4. Change the owner to Administrators.

5. Now, grant ‘Full Control’ to Administrators:
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-

-
. Permissicns for {2206CDE0-19C1-1101-89E0-00C04F... M

Securty

Group or user Names:
QJ__NETWDHK SERVICE £

E4d Administrators {0 0
52, Users | “Users)

82 Trustedinstaller s
1| 1] bareals

Pemissions for Administrators Allow Dery

Full Cortrol O
Read 0

Special permissions

For special pemissions or advanced settings,
click Advanced. =

Leam about access contral and permissions

oK ]| Cancel Apply

After this you should be able to edit MSDAINITIALIZE security settings .

See also
e Error message when you try to create an instance of an OLE DB provider in SQL Server:
"Cannot create an instance of OLE DB provider"
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Using in OpenOffice and LibreOffice

Connecting to Salesforce from OpenOffice and
LibreOffice using ODBC Driver for Salesforce
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The article describes how to use Apache OpenOffice and LibreOffice to access ODBC data
sources using the respective driver. You can access Salesforce data from Open Office Base
or LibreOffice Base — desktop database management systems. Note that the Windows
version of OpenOffice is 32-bit, and you may get the error “The specified DSN contains an
architecture mismatch between the Driver and Application” when trying to access a data
source through a 64-bit ODBC Driver. To get rid of the error message, set up the 32-bit
version of the driver.

To connect to an ODBC data source from OpenOffice or LibreOffice using our driver for
Salesforce, perform the steps below:

1. Start OpenOffice or LibreOffice, click Database to open the Database Wizard.

Apache i ™
€5 OpenOffice™ 4

‘E Text Document; Drawing
Spreadsheet EE] Database
Presentation E Formula

@ Open... = |_r/_| Templates..

Alternatively, you can launch the Database Wizard from OpenOffice or LibreOffice Calc,

Writer or any other tool by choosing File > New > Database.
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iZ| Untitled 1 - O penOffice Writer

File Edit Wiew |nsert Format Table Tools Window Help

EI Mew 3 E Text Document Ctri+mM & -
2 Open.. Ctrl+O | & Spreadsheet ol
Recent Documents 3 @ Presentation S
i i PR
(3, Wizards » | T€ Drawing
@ Database
(B Close
H save Ctrl+S @ HTML Document
B saveas. Ctrieshiftes | 2 XML Form Document
Save All E Master Document
Reload ] Formula
Versions... i Labels
[& Export... iz Business Cards
Export as PDF... £, Templates and Documents
Send 3 |

2. In the Database Wizard dialog box, click Connect to an existing database, select

ODBC from the drop-down list, and click Next.
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Database Wizard

Steps Welcome to the OpenOffice Database Wizard
1.5elect database Use the Database Wizard to create a new database, open an existing database file,
2.Set up ODBC connection or connect to a database stored on a server.

3.5et up user authentication

4.5ave and proceed

What do you want to do?
(0 Create a new database

O Open an existing database file

Recently used

|Ne-.'—.- Database2

=5 Open...

(® Connect to an existing database

QODBC s
Help << Back | Mext == | Finish Cancel

3. Specify the name of the data source you want to connect to. You can either type the name
of your data source into the field, e.g. ODBC Driver for Salesforce, or you can click

Browse, double-click the data source you need, and then click Next.

Database Wizard

Steps Set up a connection to an ODBC database

1. 5elect database Enter the name of the ODBC database you want to connect to,

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

Please contact your system administrator if you are unsure about the following
settings.

Set up ODBC connection
3.5et up user authentication

4, Save and proceed

Mame of the ODBC data source on your system

Browse
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Data Source *
Choose a data source: oK
Devart ODBC Driver
Devart ODEBC Driver for SQLite_32 Cancel
Devart ODBC Driver_32bit
QDBC Driver for MySQL_32bit Help
QOrganize...
Database Wizard e
Steps Set up a connection to an ODBC database
1.Select database Enter the name of the ODBC database you want to connect ta.

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

o Please contact your system administrator if you are unsure about the following
3.5et up user authentication settings.

2.5et up ODBC connection

4.Save and proceed

MName of the ODBC data source on your system

Devart ODBC Driver_32bit

Help << Back Mext == Einish Cancel

4. If your database requires a user name, type it into the User name field. If you are
connecting to a password protected database, check the Password required field.

Alternatively, you can specify these parameters in the data source settings of your ODBC
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Driver for Salesforce and leave these fields empty in Database Wizard.

Database Wizard

Steps

1.5elect database
2.5et up ODBC connection

3. Set up user authentication

4.Save and proceed

Help

Set up the user authentication

Some databases require you to enter a user name.

User name myusername

Password reguired

Test Connection

<< Back Mext == Finish Cancel

To test the connection to your data source, click Test Connection, input your credentials

and click OK.
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= L L

Authentication Required ¥

Steps

1. Select database MESSEQE from server:

2.5et up ODBC connection A password is needed to connect to the data source .

3. 5et up user authentication

4. 5ave and proceed

Enter user name and password for:

User name
myusername

Password

—

Help Ok Cancel

Test Connection

Help << Back Mext = Finish Cancel

If you have entered valid credentials, you will see a success message. Click Next to proceed

to the final step.

5. You can keep the default selection in this dialog box and click Finish.
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Database Wizard *

Steps Decide how to proceed after saving the database

1.5elect datab . - - "
elect database Do you want the wizard to register the database in OpenOffice?

R LB LS ® Yes, register the database for me

3.5et up user authentication _
(O Mg, do not register the database

.ESEWE and proceed
After the database file has been saved, what do you want to do?

Open the database for editing
[] Create tables using the table wizard

Click 'Finish' to save the database.

Help << Back Mext = Einish Cancel

You will be prompted to give a name to your new database and select the directory where you
want to store it.
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£ save As >
= v P » This PC » Downloads * DB v O Search DB »

Organize - Mew folder 4=z o

B This PC ~ Mame Date modified Type
-J 3D Objects 2 New Database 05.06.2019 16:43  OpenDocumetr
B Deskiop
|j_: Documents
4 Downloads
D Music
&=| Pictures
B videos
e Local Disk (C)

- Mew Volume ([v <€

File name: | Mew Databaze

Save as type: | ODF Database

[+] Automatic file name Cancel
 Hide Folders extension

6. When the database opens, you will see the list of tables from your data source diplayed in

OpenOffice or LibreOffice Base workspace. To view the data from a specific table, double-
click the table name.
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Mew Databasel16.odb - OpenOffice Base

File Edit View Insert Tools Window Help

E'E'l_l
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B Create Table in Design View...
[A Use Wizard to Create Table..

‘ Description

=
ER
usres
AcceptedEventRelation 2 Nane =
Account
Forms AccountChangeEvent
AccountCleaninfo
AccountContactRole
Reports AccountContactRoleChangeEvent
'9 Solution - New Database162 - QpenOffice Base: Table Data View 5 O X
File Edit View |nsert Tools Window Help
AEEE LI EREEE R .
SolutionName | IsPublished | IsPublishedinPublickb | Status | IsReviewed | SolutionNote | O
[ |GC1020 Portable Generator Switch Malfunctioning ] O Reviewed ] If the generator 005!
Generator assembly instructions unclear O O Draft O The 005
Maintenance guidelines for generator unclear O O Draft O The 005!
Selecting the Right Generator for Your MNeeds ] O Reviewed ] GenWatt offers 005!
GC3000 Series Propane Generator Ignition | O Reviewed | The GC3000 005
Starting generator after electrical failure O O Draft O After an 005!
Electrical wiring installation for GC5060 O O Draft O The red wiring  005:
GenWatt SLA Commitments 1 O Reviewed =] GenWatt offers 005!
Electronic panel fitting loose O O Draft O On the GC3020, 005!
GenWatt Installation Services [ | Reviewed ] GenWatt 005:

7. To create an SQL query, click Queries in the Database pane, then click Create Query in

SQL View...
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MNew Database.odb - OpenOffice Base -

Eile Edit Wiew [Insert Tools Window Help

B3 - E-@y ]
[ Create Query in Design View... Description
\E= (& Use wizard to Create Query Create a query entering an SQL statement dirs

Tables |§&|. Create Query in SQL View... |
F
EEE

i

ﬁ

Forms |

Enter your query in the query text box and click Run Query (F5). The date will be fetched

from the database and displayed in Open Office or LibreOffice, respectively.

£ New Databasel6.0db : Query1 - OpenOffice Base: Query Design — O X
File Edit Miew [nsert Tools Window Help

FIEIETT I i |

2| % M- HRIRT v
SolutionName | IsPublished | IsPublishedinPublickb | Status | IsReviewed | SolutionNote
b |GC1020 Portable Generator Switch Malfunctioning O Reviewed If the generator |0
Generator assembly instructions unclear | O Draft | The 0
Maintenance guidelines for generator unclear l O Draft [l The ]
Selecting the Right Generator for Your Meeds O Reviewed GenWatt offers |0
GC3000 Series Propane Generator Ignition O Reviewed The GC3000 o
Starting generator after electrical failure l O Draft [l After an ]
Electrical wiring installation for GC3060 [l O Drraft [l The red wiring 0
GﬂTWatt SLA Commitments M M Reviewed M GenWatt offers |0
Record |1 [ of 10 mEle sl < >
SELECT * FROM Solution;
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Using in PHP

Connecting to Salesforce from PHP using ODBC Driver
for Salesforce
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PHP is one of the most popular programming languages for website development. ODBC
drivers are connectors that make PHP development database agnostic — your software
written in PHP will function with any vendor's database management system. You can use
functions like odbc_exec() to prepare and execute SQL statements against any databases
like MySQL, SQLite, PostgreSQL, etc.

PHP-based projects usually require a data storage, whether a traditional database or a cloud-
based database. You can establish a connection to them using ODBC interface. With our
ODBC drivers, you can access various data sources and retrieve tables and fields from a
database.

Below is a sample PHP script for accessing Salesforce via ODBC. The script connects to
Salesforce database and fetches all records from a table:

Step 1: Connect to ODBC data source

The odbc_connect() function is used to connect to an ODBC data source. Note that the
function takes three mandatory parameters: the data source name, username and password.
If your database is not password-protected or doesn't require a username, leave these
parameters empty. In the following example, a connection is established using the
odbc_connect() function in PHP.

<?php
$user = "myusername";
$password = "mypassword";

$oDBCConnection = odbc_connect("'DRIVER={Devart ODBC Driver for Salesforc

Step 2: Execute an SQL statement

If connection is successful, the odbc_exec() function is used to execute a SELECT
statement against the dept table in the autotest database.

$sQLQuery = "SELECT * FROM autotest.dept";
$Recordset = odbc_exec($0ODBCConnection, $SQLQuery);

Step 3: Print the result set

The odbc_fetch_row() function is used to return records from the result set. While
odbc_fetch_row() returns rows, the odbc_result_set() function prints a set of result in HTML
table. After all rows from the result set have been printed, the odbc_close() function closes
the connection.

while (odbc_fetch_row($Recordset)) {
$result = odbc_result_all($RecordSet, "border=1");
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odbc_close($0DBCConnection);
7>

You can modify this script by specifying general settings for each Devart ODBC driver to use

any of them with your PHP projects.
© 2015-2024
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Using in Power Bl

Importing Salesforce Data into Power Bl Through an
ODBC Connection

Power Bl is a popular business intelligence solution that is comprised of services, apps, and
connectors that allow you to pull raw data from various sources and create meaningful
reports. To connect Power Bl to a data source such as Salesforce, you can use a
corresponding ODBC driver.

This tutorial explores how to connect to Salesforce and import data into Power Bl Desktop
using an ODBC driver. It is assumed that you have already installed and configured a DSN for
ODBC driver for Salesforce.

1. Run Power Bl Desktop and click Get Data.

2. Select the Other category in the Get Data dialog box, then select ODBC. Click Connect
to confirm the choice.

3. In the From ODBC dialog box, expand the Data Source Name (DSN) drop-down list and
select the previously configured DSN for Salesforce

4. If you would like to enter a SQL statement to narrow down the returned results, click the
Advanced options arrow, which expands the dialog box, and type or paste your SQL
statement.

5. Click OK. If your data source is password-protected, Power Bl will prompt you for user
credentials. Type your Username and Password in the respective fields and click.

6. Now you should see the data structures in your data source. You can preview the contents
of the database objects by clicking on them.

7. To load the Salesforce data into Power Bl for analysis, select the needed table and click
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Load.
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410 Usingin Python

Installing the ODBC Driver for Salesforce

One of the most convenient methods to connect to an external database or access cloud
data from Python is via ODBC. Devart has developed a range of ODBC Drivers for Python to
work with databases and cloud services.

If you don't have Python installed on your machine, go to the Python official website, download
the appropriate installer and run it. You will also need to install the pyodbc module — the
easiest way to do that is by using the pip install pyodbc command in the Python interactive
mode. Next, you need to download the ODBC Driver for Salesforce. To use the ODBC driver

as a translation layer between the application and the database, you need to configure it by
following the installation instructions.

Connecting to Salesforce from Python using ODBC
Driver for Salesforce

Here’s an example to show you how to connect to Salesforce via Devart ODBC Driver in

Python. First we import the pyodbc module, then create a connection to the database, insert a
new row and read the contents of the EMP table while printing each row to the Python
interactive console. To execute the script, you can type the code directly in the interactive
console or add the code to a file with the .py extension and run the file from the command
prompt.

Step 1: Connect

import pyodbc _
cnxn = pyodbc.connect('DRIVER={Devart ODBC Driver for Salesforce};User ID=my

Step 2: Insert a row

Here's a simple example of how to execute an insert statement to test the connection to the
database. The script inserts a new record to the EMP table.
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cursor = cnxn.cursor(Q)
cursor.execute("INSERT INTO EMP (EMPNO, ENAME, JOB, MGR) VALUES (535,

Step 3: Execute query

The cursor.execute() function retrieves rows from the select query on a dataset. The
cursor.fetchone() function iterates over the result set returned by cursor.execute() while the
print() function prints out all records from the table to the console.

cursor = cnhxn.cursor()
cursor.execute("SELECT * FROM EMP")
row = cursor.fetchone()
while row:

print (row)

row = cursor.fetchone()
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Using in QlikView

Connecting to Salesforce from QlikView using ODBC
Driver for Salesforce

This tutorial describes how to connect and configure QlikView to retrieve data from
Salesforce for further analysis. QlikView is a data visualization tool that connects and pulls
data from different popular databases like MySQL, MongoDB, Oracle, SQL Server, Postgres,
etc. to present it in a single view. The business intelligence platform identifies relationships in
your data and discovers patterns and opportunities to support your decision making.

QlikView supports the ODBC connectivity interface for communication with external data
sources. An ODBC data source must be configured for the database you want to access.
You can create an ODBC connection using a DSN during the ODBC driver installation or
later.

To connect to an ODBC data source from QlikView using our driver for Salesforce, perform
the steps below:

1. Open the QlikView client application and click File > New. Close the Getting Started
wizard and open File > Edit Script (CTRL+E).
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@ qlikview x64 Personal Edition - [av1]

{ File | Edit View Selections Layout Settings Bookmarks Reports Tools Object Window Help

i | New ctri+N || B | | v | (2| @) 52 B K clear | @ Back @ Forward | & Lock & Unlock
= open.. Ctrl+0
= Open in Server.. Ctrl+Shift+O
Open URL...
Open FTP...
Close
Favorites 4
=l | save Ctrl+5
Save As.. F12

Save Link

Mail as Attachment...

1]
i]

are. as a LInk

vid viL (=100 4
2 P Ctr|+P
Print Sheet...
Source Control »
Export 4
| 4 Edit script... arl+e |

2. In the Data tab, choose ODBC from the Database drop-down and click Connect. Select
the Data Source you created earlier, type in the User ID and Password if your database is
password-protected. You can test the connection by choosing Test Connection. The
Connection Test succeeded message should appear. Click OK to connect to your data

source.
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V]
File Edit Insert Tab Tools Help
-l Reload #Debug | [ S| & -2 @] O [0 <1 2 Tabs Main

v |22 =

3 e

[GET

User ID

@ Connect to Data Source s

iz

|m5.lid

| | sesee| |

D

Data Sources

Devart ODEBC Dii
Drewart ODBC Driveer for Firebird
Devart ODBC Driver for Interbase
- - - Devart ODBLC Driver for bMagento
Dats  Functions Variables  Settings Dievart ODBC Ciriver for MaiChimp
. Diewart ODBC Diriver for MySEIL
Database Diata from Files | | Devart ODBE Driver for MetSuite
. Dewart ODBC Driver for Oracle

| el ~ Connect... L] Relative Faths Dievart ODBC Diriver for SOL Azure
[JUseFTP Dievart ODBC Driver for SGLite
[ Fores 32 Eit Select... Meseart ONAC Mriver bor o sce

Canecel

Help

1 for A5E

[ Show User DSMs

Test Connection...

0k Catcel Help

3. To retrieve the data from your data source, you can enter an SQL query and press F5. You

will be suggested to choose fields to be displayed.

@ Edit Script [CA\Users\EvgeniyL\Documentsynew.qvw®] - O *
File Edit Insert Tab Tools Help
Z}Reload B Debug | = S| 4 2 @] O [0 <1 2 Tabs Main v =8 =
GET]
ODBC CONNECT TO [0ODBC Driver for Salesforce]; -
SELECT * FROM Scluticn;
W
Data  Functions “ariables  Settings
Database Data from Files
| ODBC v| | Connect.. [ Rielative Paths Table Files...
JuseFTP it E
[ Farce 32 Bit Select... Q= L=
“Wieb Files...
Field Data...
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Sheet Properties [Main]

General Fields  Objects Securty Triggers

Available Fields

CreatedByld

CreatedDate

Id

lzDeleted

lsHtml

lzPublighed
lzPublishedInPublickb
lsReviewed
LastModifiedByld
LastModifiedDate
LastReferencedDate
LastViewedDate

Add =

Add All ==

< Remove

Fields Displayed in Listboxes
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4. Alternatively, you can click Select, and QlikView will show you the database structure

window where you can compose a SELECT statement for the data to be fetched. You can

choose a different database from the database drop-down list. Select the necessary tables

and fields. You can retrieve date from multiple tables and fields by selecting them and

clicking Add. When you are ready with your SELECT statement, click OK. You will get

back to the main script editor with your SQL statement. Press F5 to execute the script and

select the fields to be displayed in QlikView.
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5. Once the data has been fetched, you can choose a table layout to present the data in a
table. Choose Layout > New Sheet Object > Table Box. Select the fields to be added to
the tablebox and click OK.

@ QlikView x64 Personal Edition - [CUsers\ ODBC\Documentsh 1.gvw™]
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@ qlikview x64 Personal Edition - [C\Users\EvgeniyL\Documents\new.guw®] = O x
! File Edit View Selections Layout Settings Bookmarks Reports Tools Object  Window  Help -8 X
PNE s EH S EE Y O & -&|9)Lﬁ?!§ﬂﬂclear‘|@83ck @) Forward | ﬁLock_sf"UnIock

Main

SolutionName SolutionMNote

Electrical wiring installation for GCS060 The red wiring from the top electronic panel of the GCS080 and the vellow wiring on the main generator assemby have to be connected
Electronic panel fitting loose On the GC3020, the electronic panel is known to disengage from the main generator body especially when used at the higher-end of th
GC1020 Portable Generator Switch Malfunctioning  If the generator switch is not working, remove the switch and re-assemble it. Often the switch gets displaced by a fraction of an inch pr
GC3000 Series Propane Generator Ignition The GC3000 series propane generators need to be started up using the following process if the ignition fails at the first try:

Generator assembly instructions unclear The Maintenance Manuals for the GC1020 ara currenthy in reveiw and will be shorthy updated and distributed to all customers. We have
Gen\Watt Installation Services Gen\Watt Corporation has a full-service support organization offering customers every type of installation assistance - from complete st
Gen\Watt SLA Commitments Gen\Watt offers four different SLAs with different service commitments as follows:

Maintenance guidelines for generator unclear The Maintenance Manuals for the GC1060 are currenthy in reveiw and will be shorthy updated and distributed to all customers. We have
Salecting the Right Generator for Your Needs Gen\Watt offers @ wide range of electric generators for every need -- from high-powered industrial-strength generators, to medium-capz
Starting generator after elactrical failure After an electical failure, the generator has to be manually turned off before establishing the connection again. If the generator is tumne
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Using in SSIS

SQL Server Integration Services (SSIS) is a component of SQL Server that is designed to
perform various data migration tasks. When using Devart ODBC Driver for Salesforce as a
translation layer between the data source and SSIS, the driver and SSIS communicate via
Microsoft ODBC version 3.x.

Note that when you extract data from an ODBC data source using the sQLExecDirect function,
an issue may occur: SSIS expects the ODBC 2.x behavior, while the ODBC driver continues
to fetch data from a data source via ODBC version 3.x. To prevent any issues when using
SQLExecDirect, you should force the ODBC 2.x behavior in the DSN settings: open the

Advanced Settings tab and select ver 2.x from the obec Behavior dropdown.
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String Types Default hd
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Test Connection - Cancel
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Using in Tableau

Importing Salesforce Data Into Tableau Through an
ODBC Connection

This article explains to establish and ODBC connection to Salesforce from Tableau Desktop.
Tableau is a data visualization tool that allows you to pull in raw data, perform analysis on i,
and create meaningful reports to get actionable insights. With Tableau Desktop and our suite
of ODBC drivers, you can connect to various relational and non-relational databases, both
cloud and on-premise.

1. Run Tableau Desktop.
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2. On the start page, select More... in the Connect pane.

3. Choose Other Databases (ODBC).

4. Expand the DSN drop-down list and select the DSN that you have created and configured
for Salesforce. Alternatively, if you have not created a DSN, you can choose the Driver
option and select Devart ODBC Driver for Salesforce from the drop-down.

. Click Connect.

. After a successful connection, click Sign in.

. Select the needed database and schema in Salesforce.

. You should see the list of all tables you have access to in the connected data source.

© 00 N O O

. Drag-and-drop the table name to the area where it says Drag tables here to retrieve the
data, or click New Custom SQL to write a query that will select only specific data from the
table.

10.Hit Update Now to retrieve and display the data.
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